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caractéristiques de votre 
nouveau lecteur MP3
Attrayant. Intelligent. Fiable. Et beaucoup de plaisir. Votre nouveau lecteur MP3 
vous offre tout cela et encore plus. Cet appareil à la fi ne pointe de la technologie 
vous offre un son riche et des images éclatantes de couleur. Vous adorerez 
votre nouveau lecteur MP3 ; pendant vos exercices, pour télécharger votre 
musique préférée, visionner vos vidéos ou même pour écouter la radio FM.
Un seul essai, et vous vous demanderez comment vous avez pu vivre sans lui.
NOUS AVONS AJOUTÉ LE « MULTI » 
DANS MULTIMÉDIA
Nous l’appelons un lecteur MP3 mais c’est 
encore beaucoup plus. Il vous permet de 
visionner des photos, des textes, des vidéos et 
aussi d’écouter la radio FM.
La technologie sans fi l Bluetooth intégrée 
transforme le lecteur MP3 en votre réseau 
personnel.

NAVIGATION TACTILE !
Naviguez dans les menus en touchant 
simplement l’écran tactile.

CONÇU AVEC ÉCRAN ACL COULEUR
Les images de couleurs éclatantes 
s’affi chent sur son grand écran ACL.

LÀ OÙ LA FORME RENCONTRE LA 
FONCTIONALITÉ
Bien sûr, il est mince et harmonieux. Mais il 
est aussi facile à tenir et à manipuler.

RECHERCHE FACILE !
Vous pouvez effectuer une recherche de 
fi chiers à l’aide de son navigateur convivial 
ou naviguer dans les menus en écoutant la 
musique.

DURÉE DE LECTURE PROLONGÉE ET DE 
TÉLÉCHARGEMENTS PLUS COURTS !
Une pile pleine charge peut vous offrir 
jusqu’à 35 heures de musique ou 5 heures 
de vidéo.
La durée de téléchargement est plus courte.
Grâce à sa capacité USB 2.0, le lecteur 
est beaucoup plus rapide que les modèles 
utilisant la capacité USB 1.1.

UNE MERVEILLE ACOUSTIQUE
Votre nouveau lecteur MP3 possède l’engin 
DNSeTM (Engin de son naturel numérique), 
une technologie sonore unique à Samsung 
créée pour produire une son plus riche, 
plus profond. Il vous offre une expérience 
d’écoute inimaginable.



consignes de sécurité
Signifi cation des icônes et des symboles contenus 
dans ce manuel :

AVERTISSEMENT
Indique des risques de dommages corporels ou de mort.

ATTENTION

Indique un risque potentiel de dommages corporels ou 
matériels.

ATTENTION

Veuillez respecter les consignes de sécurité suivantes 
afi n de réduire les risques d’incendie, d’explosion, 
d’électrocution ou de dommages corporels lorsque vous 
utilisez votre lecteur MP3 :

REMARQUE

Indique des conseils ou des pages de référence qui 
pourraient vous aider à utiliser le lecteur.

Ne PAS tenter.

Ne PAS démonter.

Ne PAS toucher.

Suivre explicitement les directives.

Débrancher la fi che d’alimentation de la prise murale.

Appeler le centre de services pour de l’aide.

Ces symboles d’avertissement sont là pour vous protéger contre les 
dommages corporels, vous et les autres. Veuillez les respecter à la lettre. 
Après avoir lu cette section, veuillez la conserver pour consultation ultérieure.



consignes de sécurité
Ce manuel décrit le mode d’emploi approprié de votre nouveau 
lecteur MP3. Veuillez le lire attentivement afi n d’éviter de vous blesser 
ou d’endommager le lecteur. Veuillez particulièrement respecter les 
avertissements sérieux qui suivent :

PROTÉGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil 
vous-même.

Ne mouillez pas l’appareil et ne le laissez pas tomber dans l’eau. 
Si le produit devient mouillé, ne l’allumez pas. Cela peut entraîner des 
risques d’électrocution. Contactez plutôt le centre de service à la clientèle 
Samsung le plus proche.

N’utilisez pas l’écouteur lorsque vous conduisez une bicyclette, une 
automobile ou une motocyclette.
bicyclette, une automobile ou une motocyclette. Dans le cas contraire, vous 
risqueriez de provoquer un accident grave. En outre, son utilisation est interdite par 
la loi dans certaines régions.
Utiliser des écouteurs en marchant ou en joggant sur la route et en particulier sur 
un passage pour piétons peut entraîner un accident sérieux.

Pour votre sécurité, veillez à ce que le cordon des écouteurs ne 
s’emmêle pas dans vos bras ou dans d’autres objets environnants 
pendant vos exercices ou vos marches.

Ne rangez pas l’appareil dans un endroit humide, poussiéreux ou 
couvert de suie, sous peine de provoquer un incendie ou une décharge 
électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTÉGEZ-VOUS
Le port des écouteurs ou d’un casque d’écoute pendant une période 
prolongée peut causer des troubles de l’ouïe sérieux.
Une exposition prolongée à un son plus élevé que 85 dB peut avoir un effet négatif 
sur votre ouïe. Plus le son est élevé, plus le problème de l’ouïe peut être sérieux 
(une conversation ordinaire s’élève entre 50 et 60 dB et le bruit de la route à environ 
80 dB). Nous vous recommandons fortement de régler le volume sur un niveau 
moyen (le niveau moyen se situe habituellement aux 2/3 du niveau maximum).
Si vous entendez un bourdonnement, baissez le volume ou cessez 
l’utilisation des écouteurs ou du casque.

PROTÉGEZ VOTRE LECTEUR MP3
Ne rangez pas l’appareil dans un lieu où la température excède 35° C 
(95° F) (comme dans un sauna ou une voiture en stationnement par 
exemple).
Évitez tout impact brutal sur l’appareil (ex. : en cas de chute).
Ne posez pas d’objets lourds sur le lecteur.
Empêchez que des particules externes ou de la poussière ne pénètrent 
dans l’appareil.
Ne placez pas le produit près d’un objet à propriétés magnétiques.
Veillez à toujours enregistrer vos données les plus importantes. 
Samsung dénie toute responsabilité pour les pertes de données.
Utilisez toujours les accessoires fournis ou agréés par Samsung.
Évitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil 
à l’aide de produits chimiques (ex. : benzène ou diluant) sous peine de 
provoquer un incendie, une décharge électrique ou une détérioration de 
la surface.
Suivez attentivement ces instructions sous peine de provoquer des 
dommages corporels ou d’endommager l’appareil.
Si vous souhaitez imprimer ce manuel, nous vous recommandons de 
l’imprimer en couleur et de cocher l’option d’imprimante « Ajuster à la 
page » pour une meilleure lecture.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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principes fondamentaux
ARTICLES COMPRIS
Votre nouveau lecteur MP3 vous parvient accompagné des accessoires 
suivants. Si certains de ces articles sont manquants, contactez le centre de 
service à la clientèle de Samsung.

Lecteur Écouteurs Câble USB CD 
d’installation

Support
pratique

L’aspect des accessoires est susceptible d’être amélioré et modifi é, sans 
notifi cation préalable.

Comment utiliser le support pratique
Installez le lecteur sur le support pratique et posez-le sur une surface 
plane. Vous pourrez alors visionner vos vidéos sans avoir à tenir le 
lecteur en main.

Le support n’est pas fi xe ; évitez de le secouer.
REMARQUE
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VOTRE LECTEUR MP3

Écran tactile

DEL Power (alimentation)
Le DEL d’alimentation brille en 
rouge pendant le chargement de 
la pile. Il tourne au vert à la fi n du 
chargement.

 Touche d’augmentation du volume
Appuyez pour monter le volume.

 Touche de diminution du volume
Appuyez pour baisser le volume.

Trou de
réinitialisation
Si une défaillance se 
produit, appuyez sur le 
bouton de réinitialisation 
à l’aide d’un objet pointu 
pour réinitialiser le 
système.

Crochet de support pratique
Comment fi xer la dragonne au support 
pratique



principes fondamentaux _ 11

VOTRE LECTEUR MP3 (suite)

Touche Hold (Verrouillage) 
Déplacez dans la direction de la fl èche 
pour verrouiller les fonctions des 
touches.

Port USB

Touche Alimentation et lecture/pause 
Appuyez pour effectuer la lecture ou l’interrompre.
Appuyez et maintenez brièvement enfoncée pour 
allumer/éteindre l’appareil.

Prise de branchement des 
écouteurs

Écouteurs
Ils sont marqués 
d’un « L » pour 
l’écouteur de 
gauche et d’un 
« R » pour 
l’écouteur de droite. 
Ils servent aussi 
d’antenne FM pour 
le lecteur MP3.
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ÉCRANS D’AFFICHAGE
Video

1
Bluetooth/verrouillage/
témoin d’alarme 7

Témoin de lecture/pause 
et recherche

2 État de la pile 8 Témoin du mode vidéo

3 L’heure actuelle 9 Barre d’état de la lecture

4 Actuelle/durée totale de la lecture. 10 Icône Retour

5 Nom du fi chier 11 Icône Menu

6 Icône lecture/pause, recherche

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.
L’information et les icônes reliées à la lecture vidéo en cours disparaîtront 
en quelques instants. Tapez l’écran si vous souhaitez affi cher à nouveau 
l’information et les icônes reliées à la lecture vidéo en cours.

Video Track 1

11

3

1

28

7

4

6

9

10

5

REMARQUE
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ÉCRANS D’AFFICHAGE (suite)
Musique

1
Bluetooth/verrouillage/témoin
d’alarme

2 L’heure actuelle

3 État de la pile

4 Piste présentement en lecture / 
témoin du nombre de pistes

5 Ecran de lecture musicale

6 Barre d’état de la lecture

7
Actuelle/durée totale de la 
lecture.

8 Icône lecture/pause, recherche

9 Icône DNSe

10 Témoin de lecture/pause et recherche

11 Témoin du mode Musique

12 Témoin du menu parent

13 Titre de la musique

14 Témoin du mode DNSe

15 Témoin du mode Lecture

16 Icône Retour

17 Icône Menu

Audio Track 1

Songs 1/52
3

4

1

2

10

12

11

13

5

14

15
6

7

8

916

17
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ÉCRANS D’AFFICHAGE (suite)
Photo

1
Bluetooth/verrouillage/témoin
d’alarme

2 L’heure actuelle

3 État de la pile

4 Témoin Fichier actuel / Nombre 
total de fi chiers

5 Icône Image suivante

6 Icône Zoom

7 État de la lecture de musique

8 Témoin du mode Photo

9 Nom du fi chier

10 Témoin de l’image précédente

11 Icône Retour

12 Icône Menu

L’information et les icônes reliées à la photo affi chée disparaîtront en 
quelques instants. Tapez l’écran si vous souhaitez affi cher à nouveau 
l’information et les icônes reliées à la photo affi chée.
Tapez l’écran une fois pour faire apparaître l’icône Image précédente/
image suivante [ ,  ]. Tapez-le à nouveau pour affi cher l’information et 
les icônes reliées à la photo.

Picture image 1 8/17
3

4

1

2

7

9

8

510

611

12

REMARQUE

[Écran de visionnement de photos]
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ÉCRANS D’AFFICHAGE (suite)
Radio FM

1
Bluetooth/verrouillage/témoin
d’alarme

2 L’heure actuelle

3 État de la pile

4 Témoin manuel/préprogrammé

5 Icône Numéro présélectionné

6 Témoin du mode Radio

7
Témoin de la fréquence 
actuelle (MHz)

8
Témoin de localisation de la 
fréquence

9 Icône Retour

10 Icône Menu

FM Radio
3

1

2

5

8

9

10

4
7

6
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COMMENT UTILISER L’ÉCRAN TACTILE
Tapez l’écran tactile du bout des doigts.

Ne tapez pas l’écran avec force ; cela peut l’endommager.
Pour éviter d’endommager l’écran tactile, évitez d’utiliser un objet autre que vos 
doigts pour le manipuler.
Ne tapez pas l’écran tactile avec des doigts sales.
Ne tapez pas l’écran tactile avec des gants.
Il peut mal fonctionner si vous utilisez vos ongles ou un autre objet comme un stylo 
à bille.

REMARQUE
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COMMENT UTILISER L’ÉCRAN TACTILE (suite)
Selon la fonction, vous pouvez toucher l’écran dans quatre directions – vers le 
haut, vers le bas, vers la droite ou vers la gauche.
Ex. : la barre d’état de lecture pour la musique

Comment procéder 1
Maintenez votre doigt sur la barre d’état à 
l’écran et déplacez le sur le point souhaité 
avant de l’enlever.

La lecture recommence au point choisi.

Comment procéder  2
Tapez un point souhaité sur la barre d’état de 
la lecture. 
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COMMENT UTILISER L’ÉCRAN TACTILE (suite)
Ex. : Image agrandie

Comment procéder  3
Maintenez votre doigt sur l’écran et déplacez le dans la direction 
souhaitée avant de l’enlever, tel qu’indiqué dans l’illustration ci-après.

En mode zoom, déplacez votre doigt dans la direction souhaitée. 
La photo se déplace et apparaît dans cette direction.
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COMMENT UTILISER L’ÉCRAN TACTILE (suite)
Ex. : Lire le fi chier vidéo précédent/suivant

Comment procéder  4
Faites coulisser votre doigt sur la gauche ou sur la droite.

Gauche : Pour vous déplacer sur le fi chier suivant (en fonction du réglage de la 
course horizontale. Reportez-vous à la 44)

Droite : Pour vous déplacer sur le fi chier précédant (en fonction du réglage de la 
course horizontale. Reportez-vous à la 44)

Video Track 1
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CHARGEMENT DE LA PILE
Chargez-la avant d’utiliser votre lecteur pour la première fois et lorsqu’il n’a pas 
été utilisé pour une période prolongée.
Charger la pile de votre lecteur MP3 prend environ 4 heures et trente minutes 
; la durée totale du chargement peut varier en fonction des conditions de votre 
ordinateur.

1. Branchez la grande fi che du câble USB sur la prise du port USB située sur le 
dessous du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
Le DEL d’alimentation brille en rouge pendant le chargement de la pile. 
Il tourne au vert à la fi n du chargement.

1

2

DEL de 
l’alimentation
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ENTRETIEN DE LA PILE
Suivre ces simples conseils d’entretien et de rangement prolongera la durée de votre pile.
• Rechargez et rangez l’appareil dans un lieu où la température est comprise 

entre 5°C et 35°C. 
• Évitez de surcharger la batterie (12 heures au maximum). Charger ou décharger 

la batterie à des fréquences trop rapprochées peut réduire sa durée de vie.
• Comme pour tout autre produit de consommation, la durée de vie de la 

batterie raccourcit progressivement avec le temps.
Si vous chargez le lecteur pendant qu’il est branché sur un ordinateur portable, 
veillez à ce que la pile du portable soit aussi complètement chargée ou qu’il soit 
branché sur une source d’alimentation.
Le chargement de la pile ne s’effectue pas si l’ordinateur est en mode de veille ou 
lorsque le matériel est retiré en toute sécurité.

MISE SOUS ET HORS TENSION DE L’APPAREIL
Mise sous tension de l’appareil
Appuyez sur la touche et maintenez-la enfoncée 
brièvement.

L’appareil s’allume.
Mise hors tension de l’appareil
Appuyez sur la touche et maintenez-la enfoncée 
brièvement.

Le lecteur s’éteint.

Votre lecteur MP3 s’éteindra automatiquement si aucune des 
touches n’est actionnée pendant une période spécifi que en mode 
pause. Le réglage à l’usine de la fonction <Auto Power Off> (Mise 
hors tension automatique) est de 1 minute ; vous pouvez cependant en modifi er la 
durée. Reportez-vous à la 33 pour plus de détails.
Reportez-vous à la 25 pour plus de détails sur l’utilisation de la fonction <Cosmos>.

REMARQUE

REMARQUE
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LECTURE D’UN FICHIER VIDÉO
Téléchargez les fi chiers vidéo sur votre nouveau lecteur MP3 à l’aide du logiciel 
Media Studio de Samsung. Pour en savoir plus à propos de Samsung Media 
Studio, reportez-vous à la 37.
1. Tapez l’icône  sur l’écran du menu principal.

La liste des vidéos apparaît.

2. Sélectionnez un fi chier vidéo à visionner et 
tapez-le.

Le fi chier vidéo sélectionné commence à défi ler à 
l’horizontale.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

CONTRÔLE DU VOLUME
Vous pouvez régler le volume pendant qu’un fi chier est en cours de lecture ou 
interrompu.

Comment procéder  1
Appuyez sur la touche  , .

La barre de réglage du volume apparaît.
Le réglage de la dynamique se situe entre 0 et 30.
Appuyez sur la touche  pour 
augmenter le volume ou sur la touche
pour le diminuer.

Comment procéder  2
Faites coulisser votre doigt vers le haut ou vers le bas à partir du centre 
de la barre située à droite de l’écran.

La barre de réglage du volume apparaît.
Faites coulisser votre doigt vers le haut pour monter le volume et vers le bas 
pour le baisser.

REMARQUE

Video Track 1
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DÉSACTIVATION DES TOUCHES
La fonction Bloqué désactive toutes les autres touches et icônes du lecteur 
MP3. Donc, si vous en tapez une par accident pendant vos exercices par 
exemple, il ne s’arrêtera pas.
1. Poussez l’interrupteur dans le sens 

de la fl èche.
2. Poussez l’interrupteur dans le 

sens opposé à celui indiqué par la fl èche pour 
désactiver la fonction de verrouillage.

NAVIGUER DANS LES FICHIERS À L’AIDE DU 
« NAVIGATEUR DE FICHIERS »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser> 
(Dossier Navigateur).
1. Tapez l’icône sur l’écran du menu principal.

La liste de dossiers du <File Browser> (Navigateur de fi chiers) 
contenant « les vidéos, la musique, les listes de lecture, les 
diffusions de données et les textes » apparaît.

2. Sélectionnez le dossier souhaité.
3. Tapez le dossier pour affi cher la liste de fi chiers.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 

4. Sélectionnez le dossier souhaité.
5. Tapez le fi chier souhaité.

La lecture du fi chier débute.

Video Track 1

Video

Music

Playlists

Pictures

Datacasts

Texts

File Browser 1/6
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES
Votre lecteur MP3 comprend des réglages et des préférences défi nis par défaut, 
mais vous pouvez les modifi er selon votre goût afi n de personnaliser votre lecteur.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

Paramètres du style de menu
Vous pouvez modifi er les polices et le modèle du menu et supprimer le 
fond d’image du menu principal.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Menu Style> (Style de menu) et 
tapez-le.

Le menu <Menu Style> (Style du menu) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.
Options de réglage du style de menu 

Menu Design (Aspect du menu) : Pour modifi er le style d’écran du menu 
principal. Sélectionnez parmi <Cosmos> (Cosmos), <Matrix> (Matrice) et <My 
Skin> (Mon habillage). Reportez-vous aux page 25 et 26
Font (Police) : Pour modifi er la police de la langue des menus. Sélectionnez 
parmi 3 polices. Certaines langues de menu n’affi chent pas <Font> (Polices).
Reset My Skin (Réinitialiser mon habillage) : Pour recomposer le fond 
d’image de l’écran tactile à sa valeur par défaut.

Si l’écran <Settings> (Paramètres) est affi ché et que vous ne tapez à 
aucune touche pendant environ 1 minute, les paramètres non enregistrés 
sont supprimés et le lecteur revient à sa fonction précédente.

REMARQUE

REMARQUE

Settings

Menu Style
Sound

Display

Language

Time

System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite) 
Comment utiliser le menu Cosmos
Comment procéder  1
Placez votre doigt sur l’écran tactile et faites le coulisser vers le haut ou 
vers le bas. Tapez l’icône du menu principal souhaité.

Comment procéder  2
Placez votre doigt sur un emplacement vide de l’écran tactile et 
décrivez doucement un cercle. 
Tapez l’icône du menu principal souhaité.

Menu <Cosmos>
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Comment utiliser le menu Matrice
Tapez l’icône du menu principal souhaité.

Comment utiliser le menu Mon habillage
Placez le bout de votre doigt sur l’écran tactile et faites le coulisser 
à gauche ou à droite et enlevez votre doigt. Tapez l’icône du menu 
principal souhaité.

Menu <Matrix> (Matrice)

Menu <My Skin> (Mon habillage)
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Paramètres du son
Vous pouvez régler l’égaliseur maître (EQ), le bip 
sonore et la limite du volume sonore.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Sound> (Son) et tapez-le.
Le menu <Sound> (Son) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.
Options de réglage du son

Master EQ (EG princ.) : Pour optimiser les paramètres sonores.
Tapez l’icône [ , ] pour sélectionner la fréquence à régler. Les fréquences 
réglables sont : <60 Hz>, <150 Hz>, <400 Hz>, <1,1 kHz>, <3,5 kHz>, 
<8 kHz> et <14 kHz>. Tapez l’icône [ , ] pour régler le niveau de la fréquence 
sélectionnée et tapez <OK>.
Beep Sound (Signal sonore) : Permet d’activer ou de désactiver le bip sonore 
pour les opérations de l’écran tactile. Sélectionnez <Off> (Arrêt) ou <On> 
(Marche).
Volume Limit (Limitation du volume) : Permet d’éviter les problèmes de l’ouïe 
en réglant la limite du volume sonore lorsque vous utilisez les écouteurs. l’option 
<On> (Marche) limite le volume sonore à un niveau maximum de15. 
Le niveau maximum du volume est de 30 lorsque la fonction de limite est sur 
<Off> (Arrêt). Afi n d’éviter les troubles de l’ouïe, le niveau du volume revient sur 
15 lorsque vous rallumez le lecteur même si vous aviez désactivé la limite <Off> 
(Arrêt).

Il est impossible de régler le <Master EQ> (Égaliseur maître) pendant que 
le lecteur est en connexion avec le casque stéréo Bluetooth.

Settings

Menu Style

Sound

Display

Language

Time

System

REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Paramètres de l’écran
Permet de modifi er la période avant l’extinction et la luminosité de votre 
écran.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Display> (Affi cher) et tapez-le.
Le menu <Display> (Affi cher) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.

Options de réglage de l’écran
Display Off (Affi ch. Désactivé) : Si vous ne tapez aucune touche ou icône 
pendant les périodes indiquées ci-après, l’écran s’éteint automatiquement. 
Sélectionnez parmi <15 sec>, <30 sec>, <1 min>, <3 min>, <5 min> et <Always 
On> (Toujours allumé). Appuyez sur n’importe quelle touche pour rallumer 
l’écran.
Brightness (Luminosité) : Pour régler la luminosité de l’écran. Sélectionnez un 
niveau entre <0 et 10>, 10 étant le plus lumineux.

Settings

Menu Style

Sound

Display
Language

Time

System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Paramètres de la langue
Les menus de votre nouveau lecteur MP3 peuvent être réglés de façon 
à apparaître dans plusieurs langues. Il est très facile de changer la 
langue selon votre choix.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Language> (Langue) et tapez-le.
Le menu <Language> (Langue) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.

Settings

Menu Style

Sound

Display

Language
Time

System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Options de réglage de la langue

Menu (Menu) : Permet de régler la langue du menu. Tapez l’icône [  ,  ] pour 
vous déplacer sur la page précédente/suivante.
Choix disponible <English>, < >, <Français>, <Deutsch>, <Italiano>, 
<日本語>, < >, < >, <Español>, < >, <Magyar>, 
<Nederlands>, <Polski>, <Português>, <Svenska>, < >, < eština>,
< >, <Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español (Sudamérica)>, 
<Português (Brasil)>, <Indonesia>, <Ti ng Vi t>, <Bulgarian>, <Român >,
< >, <Slovenš ina> et <Slovenský>.
Contents (Sommaire) : Pour défi nir la langue de l’information de la piste et du 
texte. Tapez l’icône [  ,  ] our vous déplacer sur la page précédente/suivante. 
Choix disponible <English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Simplifi ed Chinese>, <Tranditional Chinese>, <Spanish>, 
<Russian>, <Hungarian>, <Dutch>, <Polish>, <Portuguese>, <Swedish>, 
<Thai>, <Finnish>, <Danish>, <Norwegian>, <Farsi>, <Afrikaans>, <Basque>, 
<Catalan>, <Czech>, <Estonian>, <Greek>, <Hrvatski>, <Icelandic>, 
<Rumanian>, <Slovak>, <Slovene>, <Turkish> et <Vietnamese>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Paramètres de l’heure
l’heure vous permet d’utiliser les fonctions d’horodatage, du modèle de 
la date et même le fuseau horaire.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <Time> (Heure) et tapez-le.
Le menu <Time> (Heure) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.

Options de réglage de l’heure
Date/Time Set (Réglage heure/date) : Affi che la date et l’heure actuelle. Tapez 
l’icône [ , ] pour régler chaque élément : <Year> (Année), <Month> (Mois), 
<Day> (Jour), <Hour> (Heure), <Min> (Minutes) et <AM/PM> (AM/PM). 
Date Type (Type date) : Pour régler le modèle de la date d’affi chage de 
l’horloge universelle. Sélectionnez parmi : <YY-MM-DD> (AA-MM-JJ), 
<MM-DD-YY> (MM-JJ-AA) et <DD-MM-YY> (JJ-MM-AA).
Time Zone (Fuseau hr) : Pour modifi er l’heure actuelle en sélectionnant le 
fuseau horaire d’une ville en particulier. Vous devez régler le fuseau horaire 
avant de pouvoir affi cher l’heure universelle. Reportez-vous à la 86

Settings

Menu Style

Sound

Display

Language

Time

System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Paramètres du système
Choisissez les réglages par défaut qui vous conviennent pour les 
fonctions alarme, mode de mise en marche et de mise hors tension 
automatique.
1. Tapez l’icône sur l’écran du menu principal.

Le menu <Settings> (Paramètres) s’affi che.

2. Sélectionnez <System> (Système) et tapez-le.
Le menu <System> (Système) s’affi che.

3. Tapez le style de menu souhaité.
4. Réglez les options que vous préférez et tapez 

<OK>.

Settings

Menu Style

Sound

Display

Language

Time

System
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MODIFICATION DES RÉGLAGES ET DE VOS PRÉFÉRENCES (suite)
Options de réglage du système

Sleep (Veille) : Permet d’éteindre automatiquement l’appareil après 
l’écoulement de la durée présélectionnée. Choix disponibles : <Off> (Arrêt), 
<15 min >, <30 min>, <60 min>, <90 min>, ou <120 min>.
Start Mode (Mode Début) : Permet de choisir le mode à affi cher à l’allumage 
du lecteur. Sélectionnez parmi : <Home> (Dom.) et <Last State> (Dernier état). 
Sélectionnez <Home> (Dom.) pour démarrer le système en affi chant le menu 
principal et <Last State> (Dernier état) pour affi cher le denier menu utilisé.
Auto Power Off (Extinction auto) : Permet d’éteindre automatiquement 
l’appareil lorsque aucune touche n’est actionnée avant l’écoulement de la durée 
présélectionnée en mode Pause. Sélectionnez parmi : <15 sec>, <30 sec>, 
<1 min>, <3 min>, <5 min> et <Always On> (Toujours allumé).
Default Set (Réglage par défaut) : Permet de revenir aux valeurs de réglage 
par défaut. Options disponibles : <Yes> (Oui) ou <No> (Non). 
<Yes> (Oui) permet d’initialiser tous les réglages par défaut. <No> (Non) permet 
d’annuler les réglages par défaut.
Format (Formater) : Permet de formater la mémoire interne. Options 
disponibles : <Yes> (Oui) ou <No> (Non). <Yes> (Oui) formate la mémoire 
interne et supprime tous les fi chiers du lecteur. <No> (Non) prévient le 
formatage de la mémoire interne. vérifi ez avant de formater.
About (A propos de) : Vérifi e la version de micrologiciel et la capacité de la 
mémoire.

Firmware (Firmware) - Affi che la version actuelle du micrologiciel.
Memory (Mémoire) - Indique la capacité de mémoire restante. <Used> (Utilisé) 
indique l’usage, <Remaining> (Mémoire restante) indique la capacité restante et 
<Total> (Totale) indique la capacité totale de la mémoire.

À propos de la mémoire intégrée
1 Go = 1,000,000,000 d’octets : la capacité formatée réelle peut être 
inférieure puisque le micrologiciel utilise une partie de la mémoire.

REMARQUE
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RÉINITIALISER LE SYSTÈME
Ils sera possiblement nécessaire de réinitialiser le système s’il devient 
impossible d’allumer votre lecteur MP3, s’il ne lit pas la musique ou s’il n’est pas 
reconnu par votre ordinateur lorsque vous le branchez.

Appuyez sur la touche Reset situé sur la 
partie inférieure de l’appareil à l’aide d’un 
objet pointu, comme une un trombone.

Le système est réinitialisé.
Cela n’affecte pas vos réglages ou vos fi chiers.
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samsung media studio
Samsung Media Studio est une application logicielle conviviale qui 
vous aide à répartir les fi chiers de votre ordinateur. Après avoir trié et 
réparti vos fi chiers à l’aide de Media Studio, vous pouvez les transférer 
rapidement vers votre lecteur MP3 sans avoir à effectuer une recherche 
complète de votre disque dur pour trouver le bon fi chier.

BESOINS DE L’ORDINATEUR
Votre système d’ordinateur doit posséder les caractéristiques minimales qui 
suivent afi n de pouvoir installer et exécuter Media Studio :
• Pentium 500 MHz ou plus
• Port USB 2.0
• Windows XP Service Pack 2 ou ultérieur
• DirectX 9.0 ou version ultérieure
• 100 Mo d’espace libre sur le disque dur
• Lecteur de CD-Rom (2X ou plus)
• Windows Media Player 10,0 ou ultérieur
• Résolution 1024 X 768 ou plus
• Internet Explorer 6.0 ou ultérieur
• 512 Mo de mémoire vive ou plus
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INSTALLATION DE SAMSUNG MEDIA STUDIO
Veillez à exécuter le programme d’installation de <Media Studio> dans le compte 
administrateur de votre ordinateur. Autrement, il vous sera impossible d’installer 
<Media Studio>. Reportez-vous au mode d’emploi de votre ordinateur pour trouver 
le compte administrateur.

1. Insérez le CD d’installation fourni avec le 
lecteur dans le lecteur de CD-ROM de votre 
ordinateur.

2. Cliquez sur <Install now> (Installer 
maintenant).

3. Cliquez sur <Next> (Suivant).
L’installation de <Media Studio> est lancée et crée 
l’icône  sur votre poste de travail à la fi n de 
l’installation.

Next >

ATTENTION
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO
Media Studio vous permet de sélectionner et de répartir vos fi chiers et dossiers en 
prévision d’un transfert vers votre lecteur. Cela facilite et accélère la recherche de 
fi chiers sur votre lecteur MP3. Le logiciel <Media Studio> est la méthode la plus 
facile d’effectuer un transfert de fi chier de votre ordinateur sur votre lecteur MP3.

1

2

1. Branchez la grande fi che du câble USB sur la prise du port USB située sur le 
dessous du lecteur.

2. Branchez le câble USB sur le port USB ( ) de votre ordinateur.
<USB connected> (Connexion USB) apparaît à l’écran tactile du lecteur.
<Media Studio> démarre automatiquement lorsque vous branchez le lecteur sur votre 
ordinateur.
Si le programme ne démarre pas automatiquement, double-cliquez sur l’icône 
Media Studio du bureau.

La technologie de reconnaissance musicale et les données relatives sont fournies 
par Gracenote et Gracenote CDDB® Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, 
le logo et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» 
sont des marques déposées de Gracenote. Music Recognition Service et MRS sont 
des marques de service de Gracenote. 

REMARQUE
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO (suite)
3. Cliquez sur l’icône du type de fi chier que 

vous souhaiter transférer.
Cliquez sur  pour affi cher la liste musicale.
Cliquez sur  pour affi cher la liste des fi chiers 
vidéo.
Cliquez sur  pour affi cher la liste de photos
Cliquez sur  pour affi cher la liste de etc. La 
liste ETC comprend les autres types de fi chier 
(ex. :  TXT, etc.) sauf les fi chiers musique, photo 
et vidéo.

4. Cliquez sur <Add File> (Ajouter un fi chier) 
au bas de l’écran de <Media Studio>.

La fenêtre <Open> (Ouvert) apparaît.

5. Sélectionnez les fi chiers que vous souhaitez 
ajouter et cliquez sur <Open> (Ouvrir).

Les fi chiers sélectionnés sont ajoutés sur la liste à 
gauche de l’écran de <Media Studio>.

6. Sélectionnez le fi chier à transférer sur la liste 
de gauche.

7. Cliquez sur l’icône .
Le fi chier sélectionné est transféré vers le lecteur.

[YP-P2 [MTP]]

Portable [YP-P2[MTP]]3

4

5

7

6 [YP-P2 [MTP]]

Portable [YP-P2[MTP]]
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RÉPARTITION DES DOSSIERS ET DES FICHIERS À 
L’AIDE DE SAMSUNG MEDIA STUDIO (suite)

Ne débranchez pas le câble USB pendant le transfert du fi chier. Un débranchement 
pendant le transfert peut endommager le lecteur ou votre ordinateur.
Pour éviter les connexions instables, branchez le lecteur directement sur votre 
ordinateur plutôt que par le biais d’un répéteur multiport USB.

Avant le transfert du fi chier vidéo vers le lecteur à l’aide de la fonction <Media 
Studio>, le fi chier est tout d’abord converti automatiquement au format .svi. 
La taille du fi chier est également réglée automatiquement. 
Lorsque vous transférez une photo sur le lecteur à l’aide de <Media Studio>, 
elle est automatiquement convertie au format JPG avant son transfert. 
La taille du fi chier est aussi ajustée.
Une photo transférée sur le lecteur par un autre logiciel que <Media Studio> peut 
paraître différente de l’originale.
Toutes les fonctions sont désactivées durant le branchement.
Si vous branchez le câble USB sur l’ordinateur alors que la batterie est faible, 
il faudra quelques minutes au lecteur pour se connecter à l’ordinateur.
Samsung Media Studio comprend une fonction d’aide approfondie. Si vous ne 
pouvez trouver réponse à votre question à propos de Media Studio, cliquez sur 
<MENU> (MENU) <Help> (Aide) <Help> (Aide) au haut du programme 
<Media Studio>.
Qu’est-ce que SVI ?
Samsung Audio Video interleaving (SVI) (Entrelacement audio-vidéo de Samsung) 
est un nouveau format vidéo développé et contrôlé par Samsung.

ATVATTENTION

REMARQUE
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pour visionner une vidéo
Avant de démarrer -  Transférez les fi chiers vidéo sur le lecteur à l’aide de <Media 

Studio>. Reportez-vous à la  37. Branchez les écouteurs, puis 
allumez le lecteur et vérifi ez la batterie.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

1. Tapez l’icône  sur l’écran du menu principal.
La liste des vidéos apparaît.

2. Sélectionnez un fi chier vidéo à visionner et tapez-le.
Le fi chier vidéo sélectionné commence à défi ler à l’horizontale.

PAUSE
1. Tapez l’icône [ ] en cours de lecture.

La lecture vidéo est interrompue.

2. Tapez l’icône [ ] pour recommencer la lecture.
La vidéo est lue à partir du point d’interruption.

L’information et les icônes reliées à la photo affi chée disparaîtront en quelques 
instants. Tapez l’écran si vous souhaitez affi cher à nouveau l’information et les 
icônes reliées à la photo affi chée.
Avant le transfert du fi chier vidéo vers le lecteur à l’aide de la fonction <Media 
Studio>, le fi chier est tout d’abord converti automatiquement au format .svi. 
La taille du fi chier est également réglée automatiquement. 

REMARQUE

REMARQUE
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POUR VOUS DÉPLACER SUR UNE IMAGE SPÉCIFIQUE
Comment procéder  1
1. En visionnement horizontal, appuyez 

pendant un moment sur l’icône
[ , ] en cours de lecture.

Ceci vous permet de vous déplacer vers 
l’avant ou vers l’arrière dans le fi chier 
vidéo.

2. Relâchez l’icône lorsque vous aurez 
atteint la position souhaitée.

La lecture de la vidéo démarre à partir de cette position.

Comment procéder  2
Tapez le point souhaité du début de la lecture sur la barre d’état de la 
vidéo.

La vidéo est lue à partir du point sélectionné.

Faites coulisser votre doigt sur la gauche ou sur la droite pour vous 
déplacer en avant ou en arrière en fonction du réglage de la course 
horizontale. Reportez-vous à la 44.

REMARQUE

Video Track 1
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POUR VISIONNER LE FICHIER VIDÉO PRÉCÉDENT
Comment procéder  1
Tapez l’icône [ ] dans les 3 secondes 
suivant le début de la lecture de la vidéo.
Tapez deux fois l’icône [ ] dans les 3 
secondes suivant le début de la lecture de 
la vidéo actuelle.

Comment procéder  2
Faites coulisser votre doigt sur la droite.

Vous revenez sur la vidéo précédente.

POUR VISIONNER LE FICHIER VIDÉO SUIVANT
Comment procéder  1
Tapez l’icône [ ].

Comment procéder  2
Faites coulisser votre doigt sur la gauche.

Vous passez sur la vidéo suivante.

Video Track 1

     Comment procéder  2

     Comment procéder  2

Video Track 1
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POUR UTILISER LE MENU VIDÉO
Réglage d’un signet
Lorsque vous aurez mis un signet sur une scène particulière que vous 
souhaitez revoir, vous pourrez en profi ter en tout temps.
1. Tapez l’icône [ ] à la scène souhaitée 

en cours de visionnement.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez <Bookmark> (Signet).
Le menu <Bookmark> (Signet) s’affi che.

3. Tapez <Add> (Ajouter).
La position de lecture/d’arrêt actuelle est 
défi nie comme signet.
Le symbole [ | ] s’affi che sur la barre d’état.

Si vous avez déjà mis un signet, la fenêtre « Écraser » apparaît. Si vous sélectionnez 
<Yes> (Oui), le signet déjà mis est supprimé et un nouveau signet mis en place.
Un seul signet peut être mis par fi chier vidéo et vous pouvez mettre un maximum 
de 100 signets.
La position du signet peut être légèrement différente de la position réelle.

Pour vous déplacer sur (lecture) / supprimer le signet
1. Tapez l’icône [ ] sur l’écran de 

lecture vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez <Bookmark> (Signet).
Le menu <Bookmark> (Signet) s’affi che.

3. Tapez <Go to> (Aller à) ou <Delete>
(Supprimer).

Si vous sélectionnez <Go to> (Aller à), vous vous déplacerez sur le signet 
sélectionné et la lecture débutera à partir de celui-ci.
<Delete> (Supprimer) enlève le signet sélectionné du fi chier vidéo.

Tapez l’icône [ ] pour quitter le menu.

REMARQUE

REMARQUE
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POUR UTILISER LE MENU VIDÉO (suite)
Pour régler l’engin Digital Natural Sound engine (DNSe) 
(Engin de son numérique naturel)
Pour sélectionner le son parfait pour tout genre de vidéo.
1. Tapez l’icône [ ] sur l’écran de lecture vidéo.

Le menu <Video> (Vidéo) s’affi che.
2. Tapez <DNSe>.

Le menu <DNSe> s’affi che.
3. Tapez le DNSe souhaité

Sélectionnez parmi  :  <Normal>, <Drama> 
(Drame) et <Action>.

Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son 
naturel numérique) (DNSe) est un effet sonore développé par Samsung pour 
les lecteurs MP3. L’engin vous offre différentes qualités de son pour améliorer le 
genre de musique que vous écoutez.

Pour régler la course horizontale
Vous pouvez vous déplacer à marche avant rapide dans un fi chier à différents 
intervalles lorsque vous tapez la gauche ou la droite de l’écran. Vous pouvez 
sauter un fi chier entier ou plusieurs secondes à la fois.
1. Tapez l’icône [ ] sur l’écran de lecture vidéo.

Le menu <Video> (Vidéo) s’affi che.
2. Tapez <Horizontal Stroke> (Trait horizontal).

Le menu <Horizontal Stroke> (Trait 
horizontal) s’affi che.

3. Tapez la course horizontale souhaitée.
Sélectionnez parmi : <1 File> (1 fi chier), <Seek> 
(Rechercher), <10sec Skip> (Saut de 10 s), <30sec 
Skip> (Saut de 30 s) et <1min Skip> (Saut de 1 min).
Gauche : pour vous déplacer vers l’avant à la 
vitesse de l’intervalle de course horizontale sélectionné.
Droite : pour vous déplacer vers l’arrière à la vitesse de l’intervalle de course horizontale sélectionné.
<1 File> (1 fi chier) : si vous réglez <Horizontal Stroke> (Trait horizontal) sur <1 File> (1 
fi chier), vous sélectionnez le fi chier précédent ou le suivant.
Si vous réglez l’option <Seek> (Rechercher), faites coulisser votre doigt sur la gauche/
droite pour parcourir les vitesses de lecture <x2>  <x4>  <x8>.

L’intervalle du trait horizontal peut être différent de l’intervalle de saut réel en fonction du fi chier.

Bookmark

DNSe

Horizon

Screen

Normal

Drama

Action

Bookma

DNSe

Horizon

Screen

1 File

Seek

10Sec Skip

REMARQUE

REMARQUE
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POUR UTILISER LE MENU VIDÉO (suite)
Pour défi nir la taille d’écran
Vous pouvez défi nir la taille d’écran pour la lecture vidéo.
1. Tapez l’icône [ ] sur l’écran de 

lecture vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez <Screen Size> (Taille écran).
Le menu <Screen Size> (Taille écran) 
s’affi che.

3. Tapez la taille d’écran souhaitée.
Sélectionnez parmi : <Actual> (Réelle), <Standard> (Standard), <Full> 
(Plein écra) et <Zoom> (Zoom).

Menu de la taille d’écran

<Standard> (Standard)  <Full> (Plein écran)       <Zoom> (Zoom)

Pour certains fi chiers vidéo, l’option, <Screen Size> (Taille écran) ou 
d’autres menus reliés peuvent ne pas s’affi cher.

Bookma
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REMARQUE
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POUR UTILISER LE MENU VIDÉO (suite)
Avant de démarrer - Utilisez uniquement un casque Bluetooth approuvé. 
Vérifi ez si votre casque stéréo Bluetooth est enregistré. <Connect to Headset> 
(Connexion au casque d’écoute) apparaît si le casque est enregistré. Pour plus 
de renseignements, reportez-vous à la rubrique <Pour utiliser un casque stéréo 
Bluetooth>. Reportez-vous à la 88

Pour établir la connexion avec un casque stéréo Bluetooth
Vous pouvez établir directement la connexion avec un casque stéréo 
Bluetooth enregistré en cours de visionnement d’une vidéo.
1. Tapez l’icône [ ] sur l’écran de 

lecture vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez <Connect to Headset> (Relier 
les écouteurs).

Si <Bluetooth Mode> (Mode Bluetooth) 
est réglé sur <Off> (Arrêt), il passe 
directement en mode <On> (Marche).
Lorsque la connexion est bien établie, 
l’icône [ ] apparaît à l’écran.
Le casque d’écoute Bluetooth vous permet de profi ter de la bande sonore 
d’un fi chier vidéo.

Pour couper la connexion du casque stéréo Bluetooth
1. Tapez l’icône [ ] sur l’écran de 

lecture vidéo.
Le menu <Video> (Vidéo) s’affi che.

2. Tapez <Disconnect Headset> 
(Débrancher écouteurs).

La connexion avec le casque Bluetooth 
est coupée.

<DNSe> (DNSe) ne s’affi che pas 
pendant que le lecteur est connecté avec le casque stéréo Bluetooth.
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Screen Size

Connect to Headset

Bookmark
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Screen Size
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REMARQUE
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écoute de la musique
Avant de démarrer -  Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 

batterie.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

ÉCOUTE PAR CATÉGORIE

1. Tapez l’icône sur l’écran du menu principal.
Le menu <Music> (musique) s’affi che.

2. Sélectionnez l’élément souhaité dans la liste de musique et tapez-le.
Le fi chier musical apparaît.

3. Sélectionnez un fi chier musical à écouter et tapez-le.
La lecture de la musique démarre.

REMARQUE
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ÉCOUTE PAR CATÉGORIE (suite)
Liste de fi chiers musicaux
Les renseignements reliés au fi chier incluant le nom de l’artiste, le nom de l’album, le 
titre de la pièce musicale et son genre s’affi chent en fonction de l’étiquette ID3 du fi chier 
musical approprié. Un fi chier sans étiquette ID3 s’affi che comme [unknown] (inconnu).

New Playing (En lecture) : lit un fi chier récemment lu ou se déplace sur l’écran de 
lecture du fi chier actuel.
Artists (Artistes) : lecture par artiste
Albums (Albums) : lecture par album
Songs (Chansons) : lecture en ordre numérique ou alphabétique
Genres (Genres) : lecture par genre
Playlists (Listes de lecture) : lecture par liste
Music Browser (Navig. musique) : affi che tous les fi chiers musicaux stockés dans le 
dossier Musique.

Les fi chiers musicaux MP3 et WMA sont compatibles avec votre lecteur.
Les fi chiers MP1 ou MP2 possédant uniquement une extension modifi ée vers MP3 
peuvent ne pas être lus.
Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives 
au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ 
commentaire.

REMARQUE
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PAUSE
1. Tapez l’icône [ ] ou appuyez sur la touche  en cours d’écoute.

La lecture de la musique est interrompue.

2. Tapez à nouveau l’icône [ ] ou appuyez sur la touche .
 La lecture reprend à l’endroit où vous l’avez suspendue.

LECTURE DE LA PISTE EN COURS À PARTIR DU DÉBUT
1. Tapez l’icône [ ] après 3 secondes d’écoute.

La piste en cours est lue à partir du début.

LECTURE DE LA PLAGE PRECEDENTE
Comment procéder  1
Tapez l’icône [ ] en dedans de 3 secondes 
d’écoute.
Tapez deux fois l’icône [ ] après 3 secondes 
d’écoute.

Comment procéder  2
Faites coulisser votre doigt sur la droite.

La lecture de la piste précédente démarre.

Si vous lisez des fi chiers VBR, la piste précédente peut ne pas jouer même si vous 
tapez l’icône [ ] en dedans de 3 secondes.

Songs 52/52

Audio Track 0

Comment procéder  2

ATTENTION
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POUR ÉCOUTER LA PISTE SUIVANTE
Comment procéder  1
Tapez l’icône [ ].

Comment procéder  2
Faites coulisser votre doigt sur la droite.

La lecture de la piste suivante démarre.

RECHERCHE SUR UNE PISTE
Comment procéder  1
1. Appuyez sur l’icône [ ] ou [ ] pendant 

quelques instants en cours de lecture de la piste 
sélectionnée.

Ces touches permettent d’effectuer la recherche vers 
le début ou la fi n de la piste.

2. Relâchez l’icône au point où vous souhaitez 
débuter.

La lecture débute au point où vous avez relâché 
l’icône.

Comment procéder  2
Tapez un point souhaité sur la barre d’état de la lecture.

Faire glisser votre doigt vers la gauche ou la droite permet d’avancer ou de 
reculer en fonction du réglage du trait horizontal. Reportez-vous à la 62

Songs 1/52

Audio Track 1

Comment procéder  2

Songs 2/52

Audio Track 2
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG
<Media Studio> (Média Studio) vous permet de créer votre propre collection ou 
liste de lecture de fi chiers audio.

Avant de démarrer -  Branchez le lecteur sur l’ordinateur.
Media Studio doit être installé sur l’ordinateur.

Comment créer une liste de lecture

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de <Media 
Studio> (Média Studio).

La fenêtre <Playlists> (Listes de lecture) apparaît.
2. Cliquez sur la touche <New Playlists> (Nouvelles listes de lecture) au 

bas de l’écran.
La fenêtre <Create Playlists> (Créer des listes de lecture) apparaît.

3. Tapez le titre de la liste de lecture et cliquez sur [OK].
Une nouvelle liste de lecture est créée et stockée dans la section <Playlists> 
(Listes de lecture) de <Media Studio> (Média Studio).

2

1
[YP-P2 [MTP]]

OK 3

Portable [YP-P2[MTP]]
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG (suite) 

Comment ajouter des fi chiers musicaux sur une liste de 
lecture que vous avez créée

1. Cliquez sur la touche <My PC> (Mon ordinateur) au haut de <Media Studio>.
La fenêtre <My PC> (Mon ordinateur) apparaît.

2. Cliquez sur la touche <Playlists> (Listes de lecture) dans le coin droit de la 
fenêtre.

La fenêtre <Playlists> (Listes de lecture) apparaît.

3. Cliquez deux fois sur l’album souhaité dans la fenêtre de droite.
4. Sélectionnez les fi chiers que vous souhaitez transférer dans la 

fenêtre <My PC> (Mon ordinateur). 
5. Cliquez sur l’icône .

Les fi chiers sélectionnés sont ajoutés sur la liste de lecture.

5

1

3
4

2
[YP-P2 [MTP]]
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POUR CRÉER UNE LISTE DE LECTURE À L’AIDE DE 
MÉDIA STUDIO DE SAMSUNG (suite)

Exporter une liste de lecture vers votre lecteur à 
l’aide de Média Studio

1. Cliquez sur <Playlists> (Listes de lecture) dans le haut de <Media 
Studio> (Média Studio).

La fenêtre <Playlists> (Listes de lecture) apparaît.

2. Sélectionnez une liste de lecture dans la section <Playlists> (Listes 
de lecture).

3. Cliquez sur l’icône .
La liste de lecture sélectionnée est transférée sur le lecteur dossier par 
dossier avec <File Browser> (Navigateur de fi chiers)  <Playlists> (Listes 
de lecture).

Le lecteur peut lire jusqu’à 400 listes de lecture et jusqu’à 400 fi chiers 
musicaux pour chaque liste de lecture.REMARQUE
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POUR CRÉER UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP3
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP3, vous pouvez 
créer une liste de lecture « favorite » sans avoir à utiliser Media Studio ou votre 
ordinateur.
1. Tapez l’icône sur l’écran du menu principal.
2. Sélectionnez <Music> (Musique) et tapez-le.

Le fi chier musical apparaît.

3 Sélectionner un fi chier à ajouter à la liste de lecture et 
tapez l’icône [ ].

Le menu de la liste de lecture s’affi che

4. Tapez <Add to Playlist> (Aj. à liste lect.).
<Playlist 1> (List lect 1) à <Playlist 5> (List lect 1) apparaît.

5. Tapez le numéro de la liste de lecture dans laquelle vous 
souhaitez ajouter le fi chier sélectionné.

Le fi chier sélectionné est intégré dans la liste de lecture.
Vous pouvez vérifi er la liste de lecture dans <Music> (Musique) 

 <Playlists> (Listes de lecture)  <Playlist 1> (List lect 1) à 
<Playlist 5> (List lect 5) du menu principal.

Vous pouvez ajouter jusqu’à 200 fi chiers musicaux dans 
chaque liste de lecture (<Playlist 1>(List lect 1) à <Playlist 5> 
(List lect 5)).

REMARQUE
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LECTURE D’UNE LISTE DE LECTURE
1. Tapez l’icône sur l’écran du menu principal.

La liste musicale apparaît.

2. Sélectionnez <Playlists> (Listes de lecture) et tapez-le.
La/Les liste(s) de lecture s’affi che(nt).

3. Sélectionnez la liste de lecture souhaitée et tapez-la.
Les fi chiers musicaux apparaissent dans la liste de lecture 
sélectionnée a pparaissent.
Si une liste de lecture n’est pas trouvée, le message <No File> 
(Aucun fi chier) s’affi che à l’écran.

4. Sélectionnez un fi chier musical à écouter et tapez-le.
La lecture du fi chier musical débute.

Reportez-vous aux page 51 et 53 pour savoir comment 
transférer la liste de lecture avec <Media Studio>.

Playlists

Playlist 1
Playlist 2

Playlist 3

Playlist 4

Playlist 5

Song 1
Song 4

Song 6

Song 8

Song 9

Playlist 1 1/5

REMARQUE
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POUR SUPPRIMER UN FICHIER DE LA LISTE DE 
LECTURE
1. Tapez l’icône sur l’écran du menu principal.

La liste musicale s’affi che.

2. Sélectionnez <Playlists> (Listes de lecture) et tapez-le.
La/Les liste(s) de lecture s’affi che(nt).

3. Sélectionnez la liste de lecture souhaitée et tapez-la.
Les fi chiers musicaux apparaissent dans la liste de lecture 
sélectionnée a pparaissent.

4. Sélectionnez un fi chier à ajouter à la liste de lecture et 
tapez l’icône [ ].

Le menu de la liste de lecture s’affi che.

5. Tapez <Delete from Playlist> (Suppr. de liste lect.).
Une fenêtre de confi rmation s’affi che.

6. Tapez <Yes> (Oui).
Le fi chier sélectionné est supprimé de la liste de lecture.

Il est impossible de supprimer le fi chier sélectionné alors qu’il est en cours de lecture.

POUR SUPPRIMER TOUS LES FICHIERS DE LA LISTE 
DE LECTURE
Suivez les étapes 1 à 3 ci-dessus.
4. Tapez l’icône [ ].

Le menu de la liste de lecture apparaît.

5. Tapez <Delete All from Playlist> (Suppr. tt de liste lect.).
Une fenêtre de confi rmation s’affi che.

6. Tapez <Yes> (Oui).
Tous les fi chiers sont supprimés de la liste de lecture.

Song 1
Song 4

Song 6

Song 8

Song 9

Add to Playlist

Delete from Playlist

Delete All from Playlist

Playlist 1 1/5
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POUR UTILISER LE MENU MUSIQUE
Le menu Musique vous permet d’organiser tous les aspects de l’écoute en 
cours de lecture – depuis la lecture en boucle de pistes et d’albums à la 
sélection du fond d’écran.

Pour régler les effets sonores
Pour profi ter d’un son plus clair.
1. Tapez l’icône [ ] sur l’écran de lecture 

musicale.
Le menu <Music> (Musique) s’affi che.

2. Tapez <Sound Effect> (Effets Sonores).
Le menu <Sound Effect> (Effets Sonores) s’affi che.

3. Tapez l’effet sonore souhaité.
Sélectionnez entre <Street Mode> (Mode Rue) et 
<Clarity> (Netteté).

Options des effets sonores
Street Mode (Mode Rue) : Pour écouter de la musique plus nette en extérieur 
en fi ltrant certains bruits de la rue. Sélectionnez <Off> (Arrêt) ou <On> (Marche).
Clarity (Netteté) : Pour écouter une musique plus nette à qualité améliorée. 
Sélectionnez <0 à 2>.

Tapez l’icône [ ] pour quitter le menu.
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POUR UTILISER LE MENU MUSIQUE (suite)
Pour régler l’engin Digital Natural Sound engine 
(DNSe) (Engin de son numérique naturel)
Permet de choisir le type de son convenant le mieux à chaque genre de 
Musique.
1. Tapez l’icône [ ] sur l’écran de lecture 

musicale.
Le menu <Music> (Musique) s’affi che.

2. Tapez <DNSe>.
Le menu <DNSe> s’affi che.

3. Tapez l’une des options DNSe.
Sélectionnez parmi : <Normal>, <Studio>, <Rock>, 
<Classical> (Classique), <Jazz>, <Ballad> (Ballade), 
<Club>, <Rhythm & Blues> (R&B), <Dance> 
(Danse), <Concert Hall> (Salle de concert) et <User> 
(Utilisateur).
Sélectionner <User> (Utilisateur) vous permet de régler <EQ> (EG) et 
<3D&Bass> (3D&Bass). Reportez-vous à la 59

Vous pouvez aussi régler DNSe en touchant l’icône [DNSe] à l’écran de 
lecture musicale.
Qu’est-ce que l’engin DNSe ?
Digital Natural Sound Engine (Engin de son naturel numérique) (DNSe) 
est un effet sonore développé par Samsung pour les lecteurs MP3. 
L’engin vous offre différentes qualités de son pour améliorer le genre de 
musique que vous écoutez.

REMARQUE
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POUR UTILISER LE MENU MUSIQUE (suite)
Pour régler l’engin Digital Natural Sound engine 
(DNSe) (Engin de son numérique naturel) (suite)
<3D&Bass> (3D et graves)
Permet de régler l’effet sonore en 3D et 
l’enrichissement des graves.
1 Tapez l’icône [ ] dans <User> (Utilisateur).

L’écran <User> (Utilisateur) apparaît.
2. Tapez <3D&Bass>.

L’écran de réglage de <3D&Bass> apparaît.
3. Sélectionnez <3D> (3D) ou <Bass> (Graves) et tapez 

l’icône [ , ] pour défi nir l’élément souhaité.
Vous pouvez sélectionner entre <0 et 4> pour l’option 
<3D> (3D) et <Bass> (Graves).

4. Tapez <OK>.
Le réglage est terminé.

<EQ> (EG)
Vous pouvez ajuster des fréquences individuelles pour 
régler le son selon vos préférences.
1 Tapez l’icône [ ] dans <User> (Utilisateur).

L’écran <User> (Utilisateur) apparaît.
2. Tapez <EQ> (EG).

L’écran de réglage de <EQ> (EG) apparaît.
3. Tapez l’icône [  ,  ] pour sélectionner la fréquence 

à ajuster puis tapez l’icône [ , ] pour ajuster le 
niveau de la fréquence.

Les fréquences réglables sont : <60 Hz>, <150 Hz>, 
<400 Hz>, <1,1 kHz>, <3,5 kHz>, <8 kHz> et <14 kHz>.
Vous pouvez sélectionner un niveau de fréquence de 
<–10 à +10>.

4. Tapez <OK>.
Le réglage est terminé.

User

OK Cancel
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OK Cancel
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POUR UTILISER LE MENU MUSIQUE (suite)
Pour régler le mode de lecture
Sélectionnez un mode de lecture tel que Répéter.
1. Tapez l’icône [ ] sur l’écran de lecture 

musicale.
Le menu <Music> (Musique) s’affi che.

2. Tapez <Play Mode> (Mode lecture).
Le menu <Play Mode> (Mode lecture) s’affi che.

3. Tapez le mode de lecture souhaité.
Sélectionnez parmi : <Normal>, <Repeat> (Répéter), 
<Repeat One> (Répéter 1X) et <Shuffl e> (Aléatoire).

Options du mode de lecture
Normal : Lecture ponctuelle et dans l’ordre de toutes les pistes.
Repeat (Répéter) : Pour la lecture en boucle de tous les fi chiers.
Repeat One (Répéter 1X) : Répétition ponctuelle d’un fi chier.
Shuffl e (Aléatoire) : Lecture aléatoire des fi chiers.
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POUR UTILISER LE MENU MUSIQUE (suite)
Pour sélectionner l’écran de lecture musicale
Faites le choix d’un fond d’écran parmi ceux disponibles ou choisissez 
votre propre image à affi cher lorsque vous écoutez de la musique.
1. Tapez l’icône [ ] sur l’écran de lecture 

musicale.
Le menu <Music> (Musique) s’affi che.

2. Tapez <Music Play Screen> (Ecran de lecture 
musicale).

Le menu <Music Play Screen> (Ecran de lecture 
musicale) s’affi che.

3. Tapez l’icône [  , ] pour sélectionner un 
écran de lecture musicale puis tapez <OK>.

Sélectionnez parmi : <Type 1>, <Type 2>, <Type 3>, 
<Type 4>, <Album Info.> (Info. Album) et <Album Art> 
(Image CD).

Options de l’écran de lecture musicale
Type 1 ~ Type 4 (Type 1 à Type 4) : Pour sélectionner un écran de lecture musicale.
Album Info. (Info. album) : Les renseignements comprenant le nom de l’artiste, 
l’album et son genre s’affi chent si l’information de l’étiquette ID3 est stockée sur le 
fi chier musical.
Album Art (Image CD) : L’image de la jaquette de l’album s’affi che si elle est 
comprise dans l’information de l’étiquette ID3 du fi chier musical. Les images de 
jaquette de taille moindre que 200 pixels (à l’horizontale) x 200 pixels (à la verticale) 
sont soutenues.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations 
relatives au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un 
champ commentaire.

REMARQUE
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POUR UTILISER LE MENU MUSIQUE (suite)
Pour ajouter un son d’alarme
Vous pouvez ajouter votre fi chier musical favori à la liste 
des sons d’alarme et il se fera entendre la prochaine 
fois que l’alarme se déclenchera. Voir la page 82 pour le 
réglage de l’alarme.
1. Sélectionnez un fi chier musical à ajouter aux sons 

d’alarme [ ].
Le menu <Music> (Musique) s’affi che.

2. Tapez <Add to Alarm> (Ajouter à alarme).
La fenêtre Enregistrer apparaît.

3. Tapez <OK>.
Le fi chier musical sélectionné est ajouté sur la liste 
des sons d’alarme.
Un seul fi chier musical peut être ajouté aux sons 
d’alarme.

Pour régler la course horizontale
Vous pouvez régler l’intervalle de la course horizontale de 
la lecture de musique en faisant coulisser votre doigt sur 
la gauche ou sur la droite.
1. Tapez l’icône [ ] sur l’écran de lecture musicale.

Le menu <Music> (Musique) s’affi che.
2. Tapez <Horizontal Stroke> (Trait horizontal).

Le menu <Horizontal Stroke> (Trait horizontal) s’affi che.
3. Tapez la course horizontale souhaitée.

Sélectionnez parmi : <1 File> (1 fi chier), <5sec Skip> 
(Saut de 5s), <10sec Skip> (Saut de 10 s), <30sec 
Skip> (Saut de 30 s) et <1min Skip> (Saut de 1 min).

Si le fi chier a été enregistré à taux de débit variable, 
la longueur réelle de la course horizontale peut ne 
pas ressembler exactement à celle que vous avez sélectionnée.

REMARQUE

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Songs 2/52

Audio Track 1

OK Cancel

Save?

Sound Effect

DNSe

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Songs 2/52

Audio Track 1

1 File

5sec Skip

10sec Skip

30sec Skip

1min Skip



écoute de la musique _ 63

POUR UTILISER LE MENU MUSIQUE (suite)
Avant de démarrer - Utilisez uniquement un casque Bluetooth approuvé. 
Vérifi ez si votre casque stéréo Bluetooth est enregistré. <Connect to Headset> 
(Connexion au casque d’écoute) apparaît si le casque est enregistré. Pour plus 
de renseignements, reportez-vous à la rubrique <Pour utiliser un casque stéréo 
Bluetooth>. Reportez-vous à la 88

Pour établir la connexion avec un casque stéréo Bluetooth
Vous pouvez établir directement la connexion avec un 
casque stéréo Bluetooth enregistré en cours d’écoute 
musicale.

1. Tapez l’icône [ ] sur l’écran de lecture musicale.
Le menu <Music> (Musique) s’affi che.

2. Tapez <Connect to Headset> (Relier les 
écouteurs).

Si <Bluetooth Mode> (Mode Bluetooth) est réglé sur 
<Off> (Arrêt), il passe directement en mode <On> 
(Marche).
Une fois la connexion établie, l’icône [ ] s’affi che 
à l’écran.
Vous pouvez écouter la musique avec le casque 
Bluetooth.

Pour couper la connexion du casque 
stéréo Bluetooth
1. Tapez l’icône [ ] sur l’écran de lecture musicale.

Le menu <Music> (Musique) s’affi che.

2. Tapez <Disconnect Headset> (Débrancher
écouteurs).

La connexion avec le casque Bluetooth est coupée.

<Sound Effect> (Effets sonores) et <DNSe> (DNSe) 
ne s’affi chent pas pendant que le lecteur est 
connecté avec le casque stéréo Bluetooth.
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Horizontal Stroke

Connect to Headset

Songs 2/52

REMARQUE

Play Mode

Music Play Screen

Add to Alarm

Horizontal Stroke

Disconnect Headset

Songs 2/52
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pour visionner des photos
Avant de démarrer -  Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

1. Tapez l’icône sur l’écran du menu principal.
La fenêtre de prévisualisation apparaît.

2. Sélectionnez la photo à visionner et tapez-la.
La photo sélectionnée s’affi che.
Tapez l’icône [ ] pour vous déplacer sur la fenêtre de 
prévisualisation.

Pour vous déplacer sur la photo 
précédente/suivante
Tapez l’icône [  , ] sur l’écran de visualisation de photo.

La photo précédente/suivante s’affi che.
L’information et les icônes reliées à la photo en cours disparaîtront en quelques instants. 
Tapez l’écran si vous souhaitez affi cher à nouveau l’information et les icônes reliées à la photo 
affi chée.
Tapez l’écran une fois pour faire apparaître l’icône Image précédente/image suivante [ ,  ]. 
Tapez-le à nouveau pour affi cher l’information et les icônes reliées à la photo.
Les fi chiers JPG sans vignette ou avec la mauvaise vignette sont affi chés [ ].
Certaines photos peuvent être lentes à s’affi cher.
Lorsque vous transférez une photo sur le lecteur à l’aide de <Media Studio>, elle est 
automatiquement convertie au format JPG avant son transfert. La taille du fi chier est aussi 
ajustée.
Le <File Browser> (Navigateur de fi chiers) est aussi utile pour rechercher une photo. 
Reportez-vous à la 23.
Vous pouvez continuer d’écouter de la musique tout en sélectionnant <Pictures> (Photos) pour le 
visionnement.

REMARQUE

REMARQUE
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POUR UTILISER LE MENU PHOTO
Pour visualiser un diaporama
Comment procéder  1
Tapez l’icône [ ] sur l’écran de prévisualisation.

L’icône [ ] apparaît à l’écran et le diaporama débute.

Comment procéder  2
1. Tapez l’icône [ ] sur l’écran de visualisation de 

photo.
Le menu <Pictures> (Images) s’affi che.

2. Tapez <Start Slideshow> (Démarrer
diaporama).

L’icône [ ] apparaît à l’écran et le diaporama 
débute.

Pour régler la vitesse du diaporama
1. Tapez l’icône [ ] sur l’écran de visualisation de photo.

Le menu <Pictures> (Images) s’affi che.

2. Tapez <Slideshow Speed> (Vitesse diaporama).
Le menu <Slideshow Speed> (Vitesse diaporama) 
s’affi che.

3. Tapez la vitesse souhaitée
Sélectionnez parmi : <Fast> (Rapide), <Normal> 
(Normale) et <Slow> (Lente).

Tapez l’icône [ ] pour quitter le menu.
REMARQUE

Start Slideshow

Slideshow Speed

Select as My Skin

View Mode

Fast

Normal

Slow
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POUR UTILISER LE MENU PHOTO (suite)
Arrêt du diaporama
Tapez l’écran en mode de diaporama.

Le diaporama s’arrête.

Pour sélectionner une photo comme fond d’écran
Vous pouvez utiliser une photo de votre choix comme fond d’écran.
1. Sélectionnez une photo à utiliser comme fond 

d’écran, puis tapez l’icône [ ].
Le menu <Pictures> (Images) s’affi che.

2. Tapez <Select as My Skin> (Sélectionner 
comme habillage).

La fenêtre Enregistrer apparaît.

3. Tapez <Yes> (Oui).
La photo sélectionnée est établie comme fond d’écran.

Start Slideshow

Slideshow Speed

Select as My Skin

View Mode
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POUR UTILISER LE MENU PHOTO (suite)
Pour sélectionner le mode de visualisation de photo
1. Tapez l’icône [ ] sur l’écran de visualisation de 

photo.
Le menu <Pictures> (Images) s’affi che.

2. Tapez <View Mode> (Mode Affi chage).
Le menu <View Mode> (Mode Affi chage) s’affi che.

3. Tapez le mode souhaité
Sélectionnez <Auto> (Automatique) ou <Horizontal> 
(Horizontal).
Si vous sélectionnez  <Horizontal> (Horizontal), la 
photo s’affi che à l’horizontale.

Pour agrandir une photo
Vous pouvez zoumer une photo.
1. Tapez l’icône [ ] sur l’écran de visualisation de 

photo.
La photo est agrandie.
À chaque fois que vous appuyez sur l’icone [ ], la 
photo s’agrandit en séquence <x2>  <x3>  <x4>.
Pour annuler l’agrandissement de la photo tapez 
l’icône [ ].

2. Faites coulisser votre doigt dans la direction 
souhaitée. Reportez-vous à la 18

Vous pouvez déplacer la photo agrandie dans la 
direction souhaitée.

Une grande photo peut prendre beaucoup de temps à s’agrandir.

Start Slideshow

Slideshow Speed

Select as M

View Mode

Auto

Horizontal

X2X2

REMARQUE
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écoute de la radio FM
Avant de démarrer -  Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.
Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

Tapez l’icône sur l’écran du menu principal.
La réception de la radio FM est activée.

POUR UTILISER LA FONCTION MUTE (MUET)
Appuyez sur la touche  en écoutant la radio FM.

Le son est désactivé.
Appuyez à nouveau sur la touche  pour reprendre 
l’écoute.

Branchez toujours vos écouteurs au lecteur lorsque vous 
recherchez ou programmez les fréquences. Les écouteurs 
sont utilisés comme antennes de réception des ondes FM
Il se peut que le lecteur ne trouve pas de fréquences FM 
disponibles dans les régions où la réception est mauvaise.
La fonction Bluetooth est désactivée pendant que vous 
écoutez la radio FM.

REMARQUE

REMARQUE

FM Radio
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RECHERCHE DE STATIONS FM
1. Appuyez sur l’icône [ , ] pendant quelques instants pour 

désactiver le mode Manuel.
<Searching> (echerche en cours) apparaît à l’écran.
La recherche s’arrête sur la fréquence la plus près du point où la 
touche est relâchée.

OU,

1. Tapez l’icône [ , ] pour progresser parmi les fréquences 
une par une en mode Manuel.

Se déplace sur les fréquences à chaque fois que vous appuyez 
sur l’icône.

FM Radio

FM Radio

 Searching 
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POUR UTILISER LE MENU RADIO FM
Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM une à la fois.
1. Tapez l’icône [ ] en mode Manuel.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <Go to Preset Mode> (Aller au mode pré-
programmation).

La réception de la radio FM est activée.
<PRESET> s’affi che.

Si aucune fréquence n’a été présélectionnée, le 
message <Preset list does not exist> (Liste présél. 
n’existe pas) apparaît et le lecteur ne passe pas en 
mode de présélection.
Si vous sélectionnez <Default Set> (Réglage par 
défaut) dans <Settings> (Paramètres)  <System> 
(Système), les présélections enregistrées sont supprimées.
Les fréquences présélectionnées sont enregistrées en ordre numérique.

Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer 
une recherche manuelle d’une fréquence à la fois 
sur la bande FM.
1. Tapez l’icône [ ] en mode Présélection.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <Go to Manual Mode> (Aller au mode 
manuel).

<MANUAL> s’affi che.

REMARQUE

FM Radio

FM Radio
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POUR UTILISER LE MENU RADIO FM (suite)
Programmation de stations sur la mémoire
Vous pouvez stocker jusqu’à 30 stations sur la mémoire du lecteur MP3 
et y retourner simplement en appuyant sur un numéro. Laissez le lecteur 
MP3 choisir uniquement les stations que vous voulez en mode manuel ou 
trouvez et stockez toutes les stations locales automatiquement.
Manuel – choisissez uniquement les stations que vous voulez 
stocker
1. Tapez l’icône [ , ] pour présélectionner une 

fréquence en mode Manuel et tapez 
l’icône [ ].

2. Tapez <Add to Preset> (Ajouter aux présél.).
La fréquence sélectionnée est défi nie comme numéro 
programmé.

Si la fréquence est déjà présélectionnée, le message 
<This preset already exists> (Cette présél. existe 
déjà.) s’affi che et la présélection est désactivée.

Écoute des stations programmées
Tapez un numéro présélectionné en mode 
Présélection.

Le numéro présélectionné est sélectionné et vous 
pouvez écouter la fréquence radio enregistrée sous 
ce numéro.
Tapez l’icône [ , ] pour vous déplacer sur le numéro 
précédent/suivant.

Tapez l’icône [ ] pour quitter le menu.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity

FM Region

FM Radio

REMARQUE
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POUR UTILISER LE MENU RADIO FM (suite)
Programmation de stations sur la mémoire (suite)
Automatique – pour enregistrer automatiquement toutes les 
stations reçues par le lecteur
1. Tapez l’icône [ ] sur l’écran Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <Auto Preset> (Présélection auto).
La fenêtre <Auto Preset> (Présélection auto) apparaît.

3. Tapez <OK>.
La fenêtre <Auto Preset> (Présélection 
automatique) apparaît et jusqu’à 30 fréquences sont 
automatiquement présélectionnées.

Annulation de la programmation automatique
Si vous souhaitez annuler la programmation automatique, appuyez sur 
une touche durant le processus.

La programmation automatique est annulée et seules les fréquences 
programmées à ce point sont enregistrées.

Si vous souhaitez écouter votre lecteur MP3 dans une autre ville, il sera 
probablement nécessaire de reprogrammer vos stations. 
Répétez simplement le processus pour supprimer les stations 
programmées et en programmer de nouvelles.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity

FM Region
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POUR UTILISER LE MENU RADIO FM (suite)
Suppression d’une station programmée
Suivez les étapes suivantes pour supprimer les fréquences tout en 
écoutant la radio FM.
1. Tapez l’icône [ ] en mode Présélection.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <Delete from Preset> (Suppr. du 
prérégl.).

La liste des fréquences présélectionnées apparaît.

3. Sélectionnez la fréquence à supprimer et 
tapez-la.

La fenêtre de confi rmation apparaît.

4. Tapez <Yes> (Oui).
Le numéro présélectionné est supprimé.
Si vous ne souhaitez pas supprimer le numéro présélectionné, 
sélectionnez <NO> (NON). 

Lorsqu’une fréquence présélectionnée est supprimée, les numéros des 
présélections suivantes sont incrémentés de 1.REMARQUE

FM Radio

Go to Manual Mode

Delete from Preset

Auto Preset

FM Sensitivity

FM Region
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POUR UTILISER LE MENU RADIO FM (suite)
Pour régler la Sensibilité FM
Permet la réception de plus ou moins de fréquences radio 
FM. Réglez la fonction <FM Sensitivity> (Sensibilité FM). 
1. Tapez l’icône [ ] sur l’écran Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <FM Sensitivity> (Sensibilité FM).
Le menu <FM Sensitivity> (Sensibilité FM) s’affi che.

3. Tapez la sensibilité de réception souhaitée.
Sélectionnez entre <High> (Haut), <Middle> (Milieu) et 
<Low> (Bas).
Sélectionner <High> (Haute) améliore la réception des 
fréquences.

Réglage de la région FM
Vous pouvez modifi er les réglages de région FM 
avant d’aller à l’étranger.
1. Tapez l’icône [ ] sur l’écran Radio FM.

Le menu <FM Radio> (Radio FM) s’affi che.

2. Tapez <FM Region> (Région FM).
Le menu <FM Region> (Région FM) s’affi che.

3. Tapez la région FM souhaitée.
Sélectionnez entre <Korea/US> (Corée/USA), 
<Japan> (Japon) et <Other Countries> (Autres pays).

Bande de fréquences par région
- Korea/US(Corée/États-Unis) : recherchez des fréquences FM 
comprises entre 87,5 MHz et 108,0 MHz pour les lecteurs de 100 kHz.
- Japan(Japon) : recherchez des fréquences FM comprises entre 
  76,0 Hz et 108 MHz pour les lecteurs de 100 kHz.
- Other Countries(Autres pays) : recherchez des fréquences FM comprises entre 87,50 MHz et 
  108,00 MHz pour les lecteurs de 50 kHz.
Si vous modifi ez la fonction <FM Region> (Région FM) de votre lecteur, les fréquences 
radio préprogrammées sont supprimées.

REMARQUE

FM Radio

Go to Preset Mode

Add to Preset

Auto Preset

FM Sensitivity
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pour utiliser la diffusion de données
<Media Studio> vous permet le transfert des données de blogue et des fi chiers 
enregistrés au format RSS sur le lecteur pour votre plaisir.

Qu’est-ce que RSS ?
RSS représente Rich Site Summary (Résumé d’un site riche) ou Really Simple Syndication 
(Syndication réellement simple). Il s’agit d’un système de transmission de données au format 
XML utilisé pour transmettre de l’information sur les sites Web fréquemment mis à jour (les 
sites de nouvelles ou les blogues) de façon plus conviviale et facile.
Qu’est-ce que la diffusion de données ?
Vous pouvez recevoir automatiquement des informations mises-à- jour sans avoir à 
accéder à des sites de nouvelles, de blogue ou UCC fréquemment visités à chaque fois.
Avant de démarrer –  Media Studio doit être installé sur votre ordinateur. Reportez-

vous à la 36.

POUR ENREGISTRER UNE CHAÎNE
Vous pouvez créer une nouvelle chaîne en vous enregistrant sur un site Web ou des 
pages Web pouvant accueillir le format RSS.
1. Cliquez sur <Subscribe> (S’abonner) en 

dessous de <Datacasts> (Diffusion de 
données) dans <Media Studio>.

2. Saisissez une adresse dans <URL> (URL) 
et cliquez sur < Next> ( Suivant).

Lorsque vous copiez une adresse Web et cliquez 
sur <Subscribe> (S’abonner), l’adresse copiée 
s’affi che automatiquement dans <URL> (URL).
La fenêtre de confi rmation apparaît si l’adresse 
Web peut accueillir le format RSS.

3. Cliquez sur <OK>.
La chaîne souhaitée est enregistrée.
L’icône  apparaît dans Diffusion de données pour l’enregistrement de la chaîne

2

2

REMARQUE
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POUR CRÉER UNE NOUVEAU GROUPE DE CHAÎNES
Vous pouvez créer un nouveau groupe de gestion des chaînes par catégorie.
1. Cliquez sur <New Group> (Nouveau groupe) en 

dessous de <Datacasts> (Diffusion de données)  
dans <Media Studio>.

2. Tapez le nom de groupe et sa description, puis 
cliquez sur <OK>.

POUR TRANSFÉRER UNE 
DIFFUSION DE DONNÉES DE <MEDIA STUDIO>

Avant de débuter – Raccordez le lecteur à votre ordinateur.
Media Studio doit être installé sur votre ordinateur. Reportez-vous à la 36.

1. <Media Studio> est lancé automatiquement 
dès que le lecteur est raccordé à votre 
ordinateur.

Si le programme n’est pas lancé automatiquement, 
double-cliquez sur l’icône  de <Media Studio> sur 
votre bureau.

2. Cliquez sur <Datacasts> (Diffusion de 
données) dans le haut de <Media Studio>.

La liste de chaînes du groupe Diffusion de données 
apparaît.

3. Cliquez sur le groupe de chaînes souhaité.
4. Cliquez sur la chaînes souhaitée.
5. Sélectionnez l’article de forum que vous 

souhaitez transférer.
6. Cliquez sur l’icône .

L’article de forum de la chaîne sélectionnée est transféré sur le lecteur dans <File Browser> (Dossier 
Navigateur)  <Datacasts> (Dif. donn).

Cliquez sur  dans le haut de <Media Studio> pour vous déplacer sur l’écran précédent.
Dans <Datacasts> (Diffusion de données) de <Media Studio> (Média Studio), si l’article possède 
une pièce jointe, vous pouvez télécharger la pièce jointe sur le lecteur. Cependant, en raison des 
politiques du site Web concerné, il peut s’avérer impossible de télécharger la pièce jointe.

REMARQUE

2

6
5

2 Portable [YP-P2[MTP]]
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VISUALISATION DES DIFFUSIONS DE DONNÉES
Vous pouvez visualisez les articles de forum des chaînes ajoutées à <Datacasts> 
(Diffusion de données).

Avant de démarrer – Transférez l’article de forum d’une chaîne sur le lecteur avec 
<Media Studio>. Reportez-vous à la 76

Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

1. Tapez l’icône sur l’écran du menu principal.
La liste des diffusions de données apparaît.

2. Sélectionnez le titre de la chaîne souhaitée et tapez-le.
Le titre est le même que celui de la chaîne ajoutée à 
<Datacasts> (Diffusion de données) de <Media Studio> (Média 
Studio).

3. Sélectionnez le titre de l’article de forum souhaité et 
tapez-le.

La liste des fi chiers apparaît.

L’icône : texte principal de l’article transféré
L’icône  : fi chier photo
L’icône : fi chier musical
L’icône  : fi chier vidéo

4. Sélectionnez un fi chier et tapez-le.
La lecture du fi chier débute.

REMARQUE

Data Cast 1/3

Datacast 1
Datacast 2

Datacast 3
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pour profi ter de l’offre prime pack
L’offre groupée Prime Pack vous permet de profi ter de plusieurs fonctions 
comme la lecture de textes, le réglage de l’alarme et la visualisation du 
calendrier ou de l’horloge universelle.

LECTURE DE TEXTE
Qu’il s’agisse d’un roman, du manuscrit d’une nouvelle histoire 
ou de votre article de recherche, le lecteur MP3 vous laisse le 
lire… tout en écoutant de la musique !

Avant de démarrer – Allumez le lecteur et vérifi ez l’état de la 
batterie. Transférez les fi chiers texte sur le lecteur à l’aide de 
<Media Studio>. Reportez-vous à la 37.
Défi nissez la langue préférée pour les textes dans <Settings> 
(Paramètres)  <Language> (Langue)  <Contents> (Contenus). 
Reportez-vous à la 29.
Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour 
vous déplacer sur l’écran du menu principal.

1. Tapez l’icône sur l’écran du menu principal.
La liste de l’offre groupée <Prime Pack> apparaît.

2. Sélectionnez <Texts> (Textes) et tapez-le.
La liste des fi chiers texte s’affi che.

3. Sélectionnez un fi chier texte et tapez-le.
La liste des fi chiers texte apparaît.
Appuyez pendant quelques instants sur l’écran tactile pour le faire 
passer en mode plein écran. Pour revenir à l’écran précédent, 
appuyez à nouveau brièvement sur l’écran tactile.

Vous pouvez également utiliser la fonction <File Browser> 
(Dossier Navigateur) pour rechercher un fi chier texte.
Votre lecteur MP3 peut accueillir le format de fi chiers TXT en mode Texte.
Vous pouvez continuer d’écouter de la musique tout en 
sélectionnant un fi chier texte.

REMARQUE

REMARQUE

Prime Pack

Texts
Alarm

Calendar

World Clock
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POUR UTILISER LE MENU TEXTE
Pour vous déplacer sur la page précédente/suivante

Comment procéder  1
Tapez l’icône [ , ] au bas de l’écran tactile.

Comment procéder  2
Faites coulisser votre doigt sur la gauche ou sur 
la droite.

Faire coulisser votre doigt sur la gauche affi che la 
page suivante tandis que coulisser sur la droite affi che 
la page précédente.

Réglage d’un signet
Mettez un signet pour revenir sur ce point dans le texte en tout temps.
1. Tapez l’icône [ ] sur la page que vous 

souhaiter visualiser à l’écran texte.
Le menu <Bookmark> (Signet) apparaît.

2. Tapez <Add Bookmark> (Ajouter signet).
L’écran texte actuel possède un signet et le symbole 
[ ] s’affi che dans le coin gauche du haut.

Si vous avez déjà mis un signet, la fenêtre 
« Écraser » apparaît. Si vous sélectionnez <Yes> 
(Oui), le signet déjà mis est supprimé et un nouveau 
signet mis en place.
Un seul signet peut être mis par fi chier texte et vous 
pouvez mettre un maximum de 100 signets.

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.

Add Bookmark

REMARQUE

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.
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POUR UTILISER LE MENU TEXTE (suite)
Accéder à/Supprimer un signet
1. Tapez l’icône [ ] sur l’écran de visualisation de 

texte.
Le menu <Bookmark> (Signet) apparaît.

2. Tapez <Go to Bookmark> (Accéd. à signet) ou 
<Delete Bookmark> (Supprimer signet).

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à Signet) et le 
supprimez du fi chier texte lorsque vous sélectionnez 
<Delete Bookmark> (Supprimer signet).

Réglage de la couleur de la visionneuse de texte
Choisissez votre couleur préférée pour affi cher le texte.
1. Tapez l’icône [ ] sur l’écran de visualisation 

de texte.
Le menu <Text> (Texte) apparaît.

2. Tapez <Text Viewer Color> 
(Coul. visionn. text).

La fenêtre du menu <Text Viewer Color> (Coul. 
visionn. text) apparaît.

3. Tapez l’icône [  ,  ] pour sélectionner une 
couleur pour le visualiseur de texte.

Sélectionnez entre <Type 1> jusqu’à <Type 9>.

4. Tapez <OK>.
La couleur du visualiseur de texte sélectionnée s’affi che.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Text Viewer Color

Type 1

OK Cancel

Texts 1 7.0%

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

A few will bring play their instruments 

The others dance and sing.

They pair off with their partners

as their tails begin to wag.Add Bookmark

Go to Bookmark

Delete Bookmark
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POUR UTILISER LE MENU TEXTE (suite)

Pour modifi er la taille de police
Vous pouvez modifi er la taille de la police du texte.
1. Tapez l’icône [ ] sur l’écran de visualisation de 

texte.
Le menu <Text> (Texte) apparaît.

2. Tapez <Font Size> (Coul. visionn. text).
Le menu <Font Size> (Coul. visionn. text) apparaît.

3. Tapez l’icône [  ,  ] pour sélectionner une 
taille de police.

Sélectionnez parmi : <Small> (Petit), <Medium> 
(Moyen) et <Large> (Grand).

4. Tapez <OK>.
La taille de la police est modifi ée.

My doggy likes to disco dance.

He boogies every night.

He dances in his doghouse

till the early morning light.

The other dogs come running

when they hear my doggy swing.

Font Size

Small

OK Cancel
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POUR RÉGLER L’ALARME 
Le lecteur possède une alarme qui peut être réglée pour se déclencher à 
l’heure voulue.

Avant de démarrer – En premier lieu, réglez l’horloge à l’heure actuelle. Reportez-
vous à la 31

1. Tapez l’icône sur l’écran du menu principal.
La liste <Prime Pack> (Pack plus) s’affi che.

2. Sélectionnez <Alarm> (Alarme) et tapez-le.
3. Tapez <New Alarm> (Nouvelle alarme).

L’écran de réglage de l’alarme apparaît.

4. Tapez le premier élément à plusieurs reprises pour 
sélectionner la fréquence de l’alarme.

Sélectionnez parmi : <Once> (Une fois), <Everyday> (Ts 
les jours), <Mon~Fri> (Lun~Ven), <Mon~Sat> (Lun~Sam), 
<Sat~Sun> (Sam~Dim) et <Off> (Désactivée).

5. Tapez le second élément.
L’écran de réglage de l’alarme apparaît.

6. Tapez l’icône [  ,  ] pour régler chaque heure, les 
minutes et AM/PM.

7. Tapez <OK> à l’écran de réglage de l’alarme.

OK Cancel

Prime Pack

Texts

Alarm
Calendar

World Clock
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POUR RÉGLER L’ALARME (suite)

8. Tapez le troisième élément à plusieurs reprises pour 
sélectionner le son de l’alarme.

Vous pouvez sélectionner parmi : <Alarm Sound 1> 
(Son alarme 1) jusqu’à <Alarm Sound 3> (Son alarme 3) ou 
les fi chiers musicaux ajoutés comme son d’alarme. 
Reportez-vous à la 62

9. Tapez le quatrième élément à plusieurs reprises pour 
sélectionner l’intervalle de l’alarme.

Après avoir réglé l’intervalle, l’alarme se déclenche en 
fonction de cet intervalle. Sélectionnez parmi : <Interval: 
3min> (Intervalle : 3 min), <Interval: 5min> (Intervalle : 5 min) 
et <Interval: 10min> (Intervalle : 10 min).

10. Tapez <OK>.
La fenêtre de confi rmation de l’enregistrement apparaît.

11. Tapez <Yes> (Oui).
Les réglages d’alarme sont ajoutés à la liste d’alarmes.

Vous pouvez enregistrer jusqu’à 7 alarmes.
REMARQUE

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm
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Alarm

New Alarm

AM 01 : 53

POUR RÉGLER L’ALARME (suite)
Pour modifi er les réglages de l’alarme
1. À l’écran d’alarme, sélectionnez le réglage à 

modifi er et tapez-le.
L’écran de réglage de l’alarme apparaît.

2. Suivez les mêmes étapes que pour une nouvelle 
alarme ci-dessus pour modifi er le réglage. 
Reportez-vous à la 82.

Pour supprimer un réglage d’alarme
1. Tapez le réglage d’alarme à supprimer à l’écran 

d’alarme.
2. Tapez l’icône [ ].

Tapez l’icône [ ] pour supprimer tous les réglages 
d’alarme.
La fenêtre Supprimer apparaît.

3. Tapez <Yes> (Oui).
Les alarmes sélectionnées sont supprimées.

Le lecteur déclenche l’alarme à l’heure programmée. 
L’alarmes s’arrête momentanément puis est déclenchée à 
nouveau en fonction de l’intervalle réglé auparavant si aucune touche n’est activée 
ou s’il n’y a pas de manipulation de l’écran tactile. Si aucune touche n’est activée 
ou s’il n’y a pas de manipulation de l’écran tactile, l’alarme se déclenche à répétition 
pendant une heure.
Si le câble USB est branché sur le lecteur, la fonction d’alarme est désactivée.

REMARQUE

ATTENTION

Once

12 : 40 AM

Alarm Sound 1

Interval : 5min

Alarm
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POUR VISUALISER LE CALENDRIER
Vous pouvez vérifi er le calendrier.

Avant de démarrer – Réglez tout d’abord l’horloge sur l’heure actuelle. Reportez-
vous à la 31.

1. Tapez l’icône sur l’écran du menu principal.
La liste <Prime Pack> (Pack plus) s’affi che.

2. Sélectionnez <Calendar> (Calendrier) et tapez-le.
L’écran <Calendar> (Calendrier) apparaît.

3. Tapez l’icône [ , ] pour sélectionner un mois.

Pour défi nir le modèle de calendrier
Vous pouvez visualiser le calendrier en modifi ant l’ordre des jours de la 
semaine.
1. Tapez l’icône [ ] sur l’écran de visualisation du 

calendrier.
Le menu <Calendar> (Calendrier) apparaît.

2. Tapez <View Type> (Type d’affi chage).
L’écran <View Type> (Type d’affi chage) apparaît.

3. Tapez l’icône [ ,  ] pour sélectionner le mode 
de visualisation, puis tapez <OK>.

Sélectionnez <Type 1> ou <Type 2>.
<Type 1> affi che du dimanche au samedi tandis que 
<Type 2> affi che du lundi au dimanche.

SUN MON TUE WEO THU    FRI SATAA

View Type

Type 1

OK Cancel

Prime Pack

Texts

Alarm

Calendar
World Clock
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POUR VISUALISER L’HORLOGE UNIVERSELLE
Vous pouvez vérifi er l’emplacement et la date et l’heure de la plupart des 
grandes villes du monde en fonction de leur fuseau horaire.

Avant de démarrer – Réglez tout d’abord l’horloge sur l’heure actuelle. 
Reportez-vous à la 31.
Réglez le fuseau horaire souhaité dans <Settings> 
(Paramètres)  <Time> (Heure)  <Time Zone> (Fuseau hr).

1. Tapez l’icône sur l’écran du menu principal.
La liste <Prime Pack> (Pack plus) s’affi che.

2. Sélectionnez <World Clock> (Horl. mond.) et tapez-le.
L’écran <World Clock> (Horl. mond.) apparaît.

3. Tapez l’icône [ , ] pour sélectionner un fuseau horaire.
Vous pouvez visualiser la date et l’heure de la ville sélectionnée.

Vous pouvez vérifi er l’heure locale du fuseau horaire suivant.
(« / » indique le fuseau horaire normal de la région)
Cape Verde / London, Lisbon / Rome, Paris / Athens, Helsinki / Moscow, Riyadh / 
Abu Dhabi, Muskat / Tashkent, Ashgabat / Alma Ata, Kathmandu / Bangkok, Jakarta / 
Hong Kong, Beijing / Seoul, Tokyo / Guam, Sydney / Okhotsk / Wellingtons, Oakland / 
Samoa, Midway / Honolulu, Hawaii / Alyeska / Los Angeles, Seattle / 
Denver, Phoenix / Chicago, Mexico City / New York, Miami, / Caracas, Santiago / 
Buenos Aires, Brasilia / The middle Atlantic 

Prime Pack

Texts

Alarm

Calendar

World Clock
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utiliser la fonction Bluetooth
Tapez l’icône [ ] pour vous déplacer sur l’écran précédent. 
Maintenez votre doigt sur l’icône [ ] pendant un instant pour vous déplacer sur 
l’écran du menu principal.

QU’EST-CE QUE LE SYSTÈME BLUETOOTH ?
Bluetooth est une spécifi cation industrielle pour les réseaux radiotéléphoniques zonaux personnels PAN 
(wireless personal area networks). Bluetooth vous offre une façon de vous connecter et d’échanger de 
l’information entre des appareils comme les téléphones cellulaires, ordinateurs portatifs, ordinateurs 
personnels, imprimantes, caméras numériques et jeux vidéo par le biais d’une fréquence radiophonique 
sécurisée à faible portée et globalement sans licence.

Le périphérique Bluetooth peut engendrer du bruit ou créer des dysfonctionnements en 
fonction des conditions d’utilisation.

Brouillage de signal physique – si vous tenez le lecteur en main et portez un casque stéréo sur la tête 
par exemple.
Lorsqu’une partie du corps vient en contact avec le système d’émission/réception du lecteur ou du 
casque stéréo.
Variation électrique suite à un brouillage en raison de l’agencement du mur, de l’angle ou du bureau.
Interférence électrique provenant d’appareils utilisant la même bande de fréquences (ex. : appareils 
médicaux, fours à micro-ondes et réseaux LAN).

Lorsque vous appariez un dispositif Bluetooth avec le lecteur, assurez-vous de le faire sur 
une distance aussi courte que possible.
Plus la distance est grande entre le lecteur et le casque stéréo, pire en est la qualité. Si la 
distance excède la limite, les communications sont coupées.
Nous vous conseillons de ne pas d’utiliser les modes de visualisation de texte ou de photo 
pendant que vous écoutez de la musique avec le casque stéréo. Cela peut entraîner la 
dégradation à la fois de la performance du lecteur et des communications Bluetooth.
Il peut s’avérer impossible de lire les fi chiers de moins que 32 kHz en fonction du modèle de 
casque stéréo.
Dans les zones où la qualité de la réception est pauvre, dans un élévateur ou sous terre par 
exemple, la connexion Bluetooth peut mal fonctionner.
La distance maximale permettant d’établir la connexion sans fi l entre le lecteur et Bluetooth 
est de 32.8feet. La connexion est automatiquement coupée si la distance est hors de cette 
limite. Même dans ce rayon, la qualité du son peut se dégrader à cause des obstacles comme 
les murs ou les portes.

REMARQUE
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POUR UTILISER UN CASQUE STÉRÉO BLUETOOTH
Vous pouvez utiliser un casque stéréo Bluetooth pour apprécier une musique 
stéréo de haute qualité, tout ça sans aucun fi l !

Avant de démarrer – Assurez-vous que l’appareil Bluetooth à connecter est 
paramétré pour un appariement. (reportez-vous au manuel d’utilisation de l’appareil)

Pour enregistrer un casque stéréo Bluetooth
(vous devez l’enregistrer une seule fois)

1. Tapez l’icône sur l’écran du menu principal.
La fenêtre de réglage Bluetooth apparaît.

2. Tapez <Yes> (Oui).
Le <Bluetooth Mode> (Mode Bluetooth) est réglé sur 
<On> (Marche).
L’icône  s’illumine.

3. Paramétrez le casque stéréo pour l’appariement.
Reportez-vous au guide d’utilisation du casque pour 
préparer ce dernier à s’apparier au lecteur.

4. Tapez <Stereo Headset> (Écouteurs Stéréo).

5. Tapez l’icône [ ].
Le lecteur recherche automatiquement tout dispositif 
Bluetooth sans avoir à toucher l’icône [ ].
Le casque à enregistrer est sur la liste.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings
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POUR UTILISER UN CASQUE STÉRÉO BLUETOOTH 
(suite)

Pour enregistrer un casque stéréo Bluetooth (suite)
6. Tapez le nom du casque que vous souhaitez enregistrer.

La fenêtre du mot de passe apparaît si le mot de passe du casque est autre 
que 0000. Reportez-vous au manuel du casque pour le mot de passe.
L’enregistrement du casque est terminé.

Vous ne pouvez utiliser la fonction Bluetooth que lorsque vous écoutez de 
la musique ou visionnez un fi chier vidéo. Elle n’est pas accueillie lorsque 
vous écoutez la radio FM.

Description de l’icône Bluetooth
 : Mode Bluetooth activé  : Raccordé à un casque stéréo

Pour désactiver le fonction Bluetooth, réglez le mode Bluetooth dans 
<Bluetooth> (Bluetooth)  <Bluetooth Mode> (Mode Bluetooth)  <Off> 
(Arrêt).

Utilisez uniquement les casques stéréo certifi és Bluetooth. Les trousses 
piéton mono ne sont pas pris en charge.

Réglez le <Bluetooth Mode> (Mode Bluetooth) à <Off> (Arrêt) s’il n’est pas 
utilisé. Le fait de laisser le <Bluetooth Mode> (Mode Bluetooth) sur <On> 
(Marche) réduit le temps utilisable de la pile.

La connexion Bluetooth peut accueillir jusqu’à 20 appareils.

Selon leur modèle, certains casques Bluetooth peuvent offrir une mauvaise 
communication avec le lecteur.

REMARQUE
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POUR UTILISER UN CASQUE STÉRÉO BLUETOOTH 
(suite)

Pour établir la connexion avec un casque stéréo 
Bluetooth enregistré

1. Tapez l’icône sur l’écran du menu principal.

2. Tapez <Stereo Headset> (Écouteurs Stéréo).

3. Tapez le casque stéréo à connecter.
L’icône [ ] s’affi che à l’écran lorsque la connexion 
est établie.
Vous pouvez connecter jusqu’à 2 casques.

4. Lancez la lecture du fi chier de votre choix.

Vous pouvez écouter de la musique à l’aide du casque 
stéréo.

Si vous ne trouvez pas le casque que vous souhaitez utiliser, procédez tout 
d’abord à son enregistrement. Reportez-vous à la 88.

Si vous éteignez puis allumez le lecteur ou le casque en l’espace d’une 
seconde, la communication Bluetooth est interrompue. 
Si vous souhaitez écouter de la musique à l’aide du casque stéréo, répétez 
les instructions ci-dessus.

Lorsque deux casques sont connectés, seul le premier peut être activé 
pour l’opération des fonctions comme lecture/arrêt et réglage du volume. 
Reportez-vous au guide d’utilisation du casque pour plus de détails.

REMARQUE

Stereo Headset

SBH100
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POUR UTILISER LE MENU BLUETOOTH

Pour déconnecter le dispositif Bluetooth

1. Tapez l’icône sur l’écran du menu principal.

2. Tapez l’icône [ ].
Le menu <Bluetooth> apparaît.

3. Tapez <Disconnect> (Déconnecté).
La fenêtre de confi rmation de coupure de la connexion 
apparaît.

4. Tapez <Yes> (Oui).
Le périphérique actuellement connecté est 
déconnecté.

Pour vérifi er le dispositif Bluetooth connecté

1. Tapez l’icône sur l’écran du menu principal.

2. Tapez l’icône [ ].
Le menu <Bluetooth> apparaît.

3. Tapez <Connected Device> (Périph. connecté)
Vous pouvez affi cher la liste des périphériques 
connectés.

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device

Bluetooth

Stereo Headset
Bluetooth Mode

Bluetooth Settings

Disconnect

Connected Device
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PARAMÈTRES BLUETOOTH
Avant de démarrer – Réglez <Bluetooth Mode> (Mode Bluetooth) sur <On>

(Marche).

1. Tapez l’icône sur l’écran du menu principal.

2. Sélectionnez <Bluetooth Settings> (Paramètres 
Bluetooth) et tapez-le.

Le menu <Bluetooth Settings> (Paramètres Bluetooth) 
apparaît.

3. Réglez les options que vous préférez et tapez <OK>.

Options de réglage de Bluetooth
Search Timeout (Délai d’Attente Recherche Dépassé) : Vous permet de 
sélectionner le temps de recherche d’un nouvel appareil. Suite au réglage d’une 
période de temps, l’appareil recherchera les nouveaux dispositifs pendant la 
période limitée que vous aurez réglée. Sélectionnez parmi <10 sec>, <20 sec>, 
<30 sec>, <45 sec> ou <60 sec>.
Delete Device (Supprimer le Périphérique) : Vous permet de supprimer un 
appareil enregistré sur le lecteur. Tapez l’icône [ ] pour supprimer tous les 
dispositifs enregistrés. Reportez-vous à la 93.
My Device Info. (Informations de Mon périphérique) : Vous pouvez vérifi er le 
nom et l’adresse de votre lecteur.

Bluetooth

Stereo Headset

Bluetooth Mode

Bluetooth Settings
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PARAMÈTRES BLUETOOTH (suite)
Pour supprimer un dispositif Bluetooth
1. Sélectionnez <Delete Device> (Supprimer le 

Périphérique) et tapez-le.
Vous verrez la liste des dispositifs enregistrés.

2. Sélectionnez un dispositif à supprimer et tapez 
l’icône [ ].

Tapez l’icône [ ] pour supprimer tous les dispositifs 
enregistrés.

3. Tapez <Yes> (Oui).
Le périphérique sélectionné est supprimé.

Pour renommer un dispositif Bluetooth
1. Sélectionnez <My Device Info.> (Informations de 

Mon Périphérique) et tapez-le.
L’écran Informations de Mon Périphérique apparaît.

2. Tapez l’icône [ ].
La fenêtre Edit Device Name (Modifi er le nom du 
périphérique) apparaît.

3. Renommez le dispositif en touchant l’icône des 
numéros ou des caractères.

[1Aa] : Le mode d’entrée bascule des numéros aux 
majuscules anglaises et aux minuscules anglaises.

[ ] : Vous pouvez supprimer les caractères un par un.
[ – ] : Vous pouvez ajouter un espace entre les caractères.
[OK] : Confi rmez votre modifi cation.
Ex. : pour saisir « YPS5 »
-Déplacez vous sur l’icône de l’autre touche et tapez-la.

(une fois) (trois fois) (une fois) (trois fois) 
(deux fois) (une fois)

1Aa

My Device Info.

Edit Device Name

Bluetooth Settings

Search Timeout

Delete Device
My Device lnfo.
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dépannage
Si vous rencontrez un problème avec votre lecteur MP3, trouvez une 
solution sur cette liste. Si le problème persiste, contactez le centre de 
service à la clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume 
pas.

• L’appareil ne s’allume pas si la pile est 
complètement à plat. Rechargez la pile et 
remettez l’appareil sous tension.

• Appuyez sur la touche Reset (Réinitialisation).

Les touches ne 
fonctionnent pas.

• Vérifi ez si l’interrupteur est dirigé dans 
le sens de la fl èche.

• Assurez-vous que vous appuyez sur le bouton et 
l’icône adéquats avant d’essayer.

• Appuyez sur la touche Reset (Réinitialisation).

L’écran ne s’allume 
pas.

• Il se peut que les données affi chées à l’écran 
ne soient pas visibles sous les rayons directs du 
soleil.

• Si vous sélectionnez <Display Off> (Affi ch. 
désactivé) dans <Settings> (Paramètres) 
<Display> (Affi cher), l’écran tactile est désactivé.
Tapez toute touche ou l’écran pour le réactiver.

L’alimentation est 
coupée.

• Vérifi ez l’état de la pile.
• L’alimentation se coupe automatiquement lorsque 

la pile est complètement à plat. Rechargez la pile.
• Si vous sélectionnez <Auto Power Off>

(Extinction auto) dans <Settings> (Paramètres) 
<System> (Système), le lecteur s’éteint 

lorsqu’il est en mode Pause. Allumez le lecteur.
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PROBLÈME SOLUTION

La durée de vie de 
la batterie diffère de 
celle indiquée dans le 
manuel.

• La durée de la pile peut varier en fonction du 
mode sonore et des réglages de l’écran.

• La durée de la pile peut être réduite si vous 
exposez l’appareil à des températures basses ou 
élevées pendant des périodes prolongées.

Défaillance du 
programme Media 
Studio

• Confi rmez que votre ordinateur possède les 
caractéristiques fondamentales.

La connexion à 
l’ordinateur est 
désactivée.

• Assurez-vous que le câble USB est branché 
correctement et essayez à nouveau.

• Cliquez sur le bouton <Start> (Démarrer) de la 
barre d’outils de votre ordinateur pour lancer la 
mise à jour de Windows. Sélectionnez les mises à 
jour principales et les ensembles de modifi cations 
provisoires (Service Packs), puis mettez tout à 
jour. Redémarrez votre ordinateur et rebranchez 
l’appareil.

Le transfert de 
fi chier s’effectue trop 
lentement.

• Le transfert est plus lent si votre ordinateur 
exécute simultanément plusieurs programmes 
incluant <Media Studio>. Quittez les programmes 
inutiles et essayez à nouveau.

Le lecteur n’effectue 
pas la lecture.

• Vérifi ez que le fi chier disponible a bien été 
enregistré dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas 
endommagé.

• Vérifi ez que la puissance de la batterie est 
suffi sante.
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PROBLÈME SOLUTION

Le téléchargement de 
fi chiers ne fonctionne 
pas.

• Vérifi ez que le câble USB est correctement 
branché. Rebranchez-le au besoin.

• Assurez-vous qu’il reste de l’espace disponible 
sur la mémoire.

• Appuyez sur la touche Reset (Réinitialisation).

Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché 
durant le transfert du fi chier ou des données. Si 
tel est le cas, les fi chiers/données mais également 
l’appareil risquent d’être endommagés. Vous 
devez faire preuve d’une extrême prudence à cet 
égard car Samsung ne saurait en aucun cas être 
tenu responsable de la perte des données.

Affi chage anormal de la 
durée de lecture.

• Confi rmez que le fi chier est au format VBR (débit 
binaire variable).

Affi chage anormal du 
nom de fi chier.

• Allez dans <Settings> (Paramètres) 
<Language> (Langue) <Contents>
(Sommaire) du menu principal et sélectionnez la 
langue appropriée.

L’appareil est chaud.
• Les phases de chargement peuvent générer de la 

chaleur. Cela n’a aucune incidence sur la durée 
de vie de l’appareil ou sur son fonctionnement.

Un message apparaît 
pendant que vous 
visionnez une vidéo.

• Tentez de télécharger le clip vidéo à nouveau 
avec Media Studio.

La connexion Bluetooth
n’a pu être établie.

• Vérifi ez si le casque stéréo est certifi é Bluetooth. 
Les casques mains libres monophoniques ne sont 
pas accueillis.

• La connexion Bluetooth peut se désactivez si vous 
éteignez et allumez le lecteur ou le casque stéréo. 
Dans ce cas, tentez une nouvelle connexion.
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annexe
ARBRE INVERSÉ DU MENU
Voici un coup d’oeil rapide sur la répartition des menus et des fonctions de votre 
nouveau lecteur MP3.

Écran de sélection du menu

Videos Music Pictures FM
Radio Datacasts Prime

Pack
File

Browser Bluetooth Settings

Texts Stereo
Headset Menu Style

Alarm Bluetooth
Mode Sound

Calendar Bluetooth
Settings Display

World Clock Language

Time

System
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CARACTÉRISTIQUES DU PRODUIT

Nom du modèle YP-P2

Caractéristiques
nominales 5,0 Vcc / 500 mA

Alimentation de la 
batterie intégrée 830 mAh / 3,7 Vcc

Fichier Compatibilité

AUDIO : MPEG1/2/2,5, couche 3 (8 kb/s à 320 kb/s, 
8 kHz à 48 kHz) WMA (8 kb/s à 320 kb/s, 8 kHz à 48 kHz)

VIDÉO : SVI (Vidéo : MPEG4, Audio : MP3 (stéréo 44,1 kHz 
16 bits, 128 kb/s), Résolution : 480x272, Vitesse de 
défi lement : environ 9 mètres par seconde (30 pi/s) 
WMV9 (Vidéo : WMV9 profi l simple, Audio :WMA9 (Max. 
860 kb/s), Résolution : 320x240 ou 480x272, Vitesse de 
défi lement : environ 9 mètres par seconde (30 pi/s)

IMAGE : JPG (ligne de base uniquement)

Sortie des écouteurs 20mW (16 )

Bande de fréquences 
de la sortie 20Hz~20KHz

Rapport signal sur bruit 89 dB avec FPB de 20 kHz (fondé sur 1 kHz - 0 dB)

Durée de lecture
Maximum de 35 heures de musique (fondé sur : MP3 128 kb/s, 
volume 20, mode de son normal), Maximum de 5 heures de lecture 
vidéo

Plage de températures 
de fonctionnement -5~35°C (23~95°F)

Étui Plastique polyméthacrylate de méthyle, acier inoxydable

Poids 86g

Dimensions (L x H x P) 52 X 100 X 9,95 mm
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Radio FM
Fréquence FM 87,5~108,0MHz T.H.D. FM 0,8%

Rapport signal 
FM 59 dB Sensibilité

FM utile 5dB

Systèmes sans fi l
Type d’émission F1D

Puissance RF 2,4mW

Fréquence d’émission 2402 MHz à 2480 MHz

Fréquence de réception 2402 MHz à 2480 MHz

Nombre de canaux 79 canaux

Température -10°C~ +50°C (14 ~ 122°F)

Système de modulation GFSK

Mode de communication Opération bidirectionnelle à l’alternat

Humidité 95%

Version prise en charge 2,0

Module BCM2048

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré 
sans notifi cation préalable.
Cet appareil numérique de la classe B est conforme à la norme NMB-003 du 
Canada.
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LICENCE
L’unité qui se trouve avec ce manuel de l’utilisateur est fournie sous licence 
sous certains droits de propriété intellectuelle de parties tierces. Cette licence 
est limitée à une utilisation privée non commerciale par l’utilisateur fi nal pour les 
contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue 
à un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 
11172-3 ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou 
décoder des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-
3.
Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des 
fonctions du produit qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou 
ISO/IEC 13818-3.



Garantie Limitée Samsung
Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.
SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant la 
période de garantie et qu’il s’agit d’un défaut de fabrication SECA se réservera le droit 
de réparer ou de remplacer l’appareil défectueux
Toutes les réparations sous garantie doivent être effectuées par un Centre de service 
autorisé SECA. Le nom et l’adresse du Centre de service le plus près de chez vous 
peut être obtenu en composant sans frais le 1-800-726-7864 ou en visitant notre site 
web au www.samsung.ca

 Main-d’oeuvre Pièces

 un (1) an (au comptoir) un (1) an

Pour tous les modèles portatifs, le transport de l’appareil sera la responsabilité du 
client. Le reçu de vente original doit être conservé par le client car cela constitue sa 
seule preuve d’achat acceptée. Il doit le présenter au Centre de service agréé au 
moment où il fait la demande d’une réparation sous garantie.
Exclusions
Cette garantie ne couvre pas les dommages causés par un accident, un incendie, une 
inondation, un cas de force majeure, un mauvais usage ou une tension incorrecte. La 
garantie ne couvre pas aussi une mauvaise installation, une mauvaise réparation, une 
réparation non autorisée et tout usage commercial ou dommages survenus durant le 
transport. Le fi ni extérieur et intérieur de même que les lampes ne sont pas couverts 
par cette garantie. Les ajustements par le client qui sont expliqués dans le guide 
de l’utilisateur ne sont pas couverts en vertu de cette garantie. Cette garantie sera 
automatiquement annulée pour tout appareil qui aurait un numéro de série manquant 
ou modifi é. Cette garantie est valable seulement sur les appareils achetés et utilisés 
au Canada.
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Si vous avez des suggestions ou des questions concernant les 
produits Samsung,

veuillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service à la Clientèle
1-800-SAMSUNG (7267864)

www.samsung.com/ca


